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HIGHLIGHTS
Here are just some of the things you can do with the X700 mobile 
phone.
• Send colour pictures and 

video clips to friends and 
family via Multimedia 
messaging and e-mail 
messaging.

• Send pictures, video, 
electronic business cards, 
and more using Bluetooth, 
Infrared, or USB connections 
to other phones or devices..

• Swap content between 
appropriate devices with the 
included miniSD Card and 
adapter.

• Surf the Internet using your 
XHTML configured wireless 
Internet browser.

• Add frames, text, and pop 
art to VGA size images.

• Capture video clips.

• Play 40 tone polyphonic 
ringtones.

• No more wired headset! 
Use a Bluetooth® wireless 
headset.

• Synchronise your Contacts 
and Calendar with your 
other networked devices.

• See who is calling with 
picture Caller Line ID on the 
X700 external display.

• Download games, images, 
themes, sounds, videos, 
and Java™ and Series 60 

applications. 

• View all your media files in 
one place, the Media Gallery.

• Search for your files; 
including games, images, 
install packages, and video 
and sound clips.

• Receive, edit, and view 
Microsoft® Word, Excel, and 
PowerPoint® files. Beam 
documents to printers and 
projectors (with appropriate 
accessory).

• Speak a name or number to 
dial the number using Voice 
Commands.

• Say “open Messages” or 
“open Camera” and your 
phone will go directly to the 
application using Voice 
Commands.
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GETTING STARTED
The Panasonic X700 GSMTM/GPRS mobile phone operates on 
Global System for Mobile Communications (GSM) networks 
around the world, which provide integrated voice mail, text short 
message service (SMS), multimedia messaging service (MMS), 
fraud protection and superior voice quality. One of the most 
important GSM advantages is the removable SIM (subscriber 
identity module) card, containing personal information such as 
subscription information, private encryption keys, and phone 
numbers.

Feature Availability
Some features are network dependent or are available only if you 
subscribe to the feature. Some functions are SIM card dependent. 
Note that before you can use or activate many of the network 
features, you must subscribe to the desired services. For more 
information, contact your wireless service provider.

Before Using Your Phone
The SIM card must be installed in your phone for it to operate on 
the cellular network. Insert SIM card, then attach battery and fully 
charge it.

INSTALLING AND REMOVING SIM CARD

Installing SIM Card
1.  Place thumbs at outer edges 

of battery cover, press down, 
then slide off battery cover 
towards bottom of phone. 
Remove battery (see page 4).

Caution: This product contains small parts. Keep out of reach of small 
children.
Take care not to scratch or bend SIM card and gold contacts.
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2. Position SIM card as shown, with 
gold contacts facing phone and 
notched corner entering phone first. 
Carefully slide the SIM card into the 
SIM card pocket until it clicks.
• If SIM card is inserted incorrectly 

or damaged, Insert SIM card may 
display. Remove SIM card, then 
install again.

• If SIM card rejected message 
appears, contact your wireless 
service provider.

Removing SIM Card
1. Place thumbs at outer 

edges of battery cover, 
press down, then slide off 
battery cover towards 
bottom of phone. Remove 
battery (see page 4).

2. Gently push bottom edge of 
SIM card forward into SIM card pocket to release SIM card. 

3. After SIM card is ejected, gently remove it.

Note: If you are upgrading your phone and your previous phone did not 
support new services, such as MMS (Multimedia Messaging 
Service), you may need to insert a new SIM card. Contact your 
wireless service provider.

SIM Card

SIM Card
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INSTALLING AND REMOVING BATTERY

Installing Battery
1. Hold battery at a 45º 

angle; insert tabs on top 
edge of battery into slots 
along top edge of 
battery area.

2. Push bottom of battery 
down until it clicks.

3. Replace battery cover 
by sliding cover toward the bottom of the phone. Cover should 
fit snugly with no gaps.

Removing Battery

1. Place thumbs at outer 
edges of battery cover, 
press down, then slide off 
battery cover towards 
bottom of phone.

2. Use tabs at bottom of 
battery to lift and remove 
battery.

3. Replace battery cover.

Caution: Using non-Panasonic accessories or accessories not 
recommended by your wireless service provider may result in 
poor performance of your phone, or even cause an electrical 
hazard.

Note: Before you remove the battery, switch off the phone and 
disconnect the phone from the charger or any other device.
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CHARGING BATTERY

1. Open connector cover.
2. Insert connector into left side 

(2 gold contacts) of 
connector area at bottom 
end of the phone. Connect 
Travel Charger into mains 
power socket.

3. When charging is complete, 
remove from mains power 
socket and press release 
button to disconnect the charger from the phone.

• DO NOT force connector: it may damage phone or Travel 
Charger.

Charging Icons on Main and External Display
 bars scroll when charging

bars stop scrolling when charging is complete

• If the phone is switched on, Battery full message displays 
when charging is complete.

Low Battery Warning
When the battery power is low, Battery low message displays 
and a warning tone sounds; phone will automatically switch off. 
Fully recharge the battery. If you receive the low battery warning 
during a conversation, finish your call immediately.

Note: First verify that battery is installed. 
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INSTALLING AND REMOVING miniSD CARD
The miniSD Card is a memory card used to expand phone 
memory and a way to transfer files to other devices.

Installing miniSD Card
1. On top of phone, lift up miniSD 

Card cover. 
2. Slide miniSD Card, with notched 

corner entering phone first and 
gold contacts facing up, into the 
miniSD Card pocket until it clicks. 
Push down miniSD Card cover 
until it clicks.

Removing miniSD Card
1. Press Power key , scroll to Eject miniSD Card and press 

OK. Before removing miniSD Card, wait for file saving or 
copying process to finish.

2. On top of phone, lift up miniSD 
Card cover.

3. To release miniSD Card, gently 
push bottom edge of miniSD Card 
forward into pocket. 

4. After miniSD Card is ejected, 
gently remove it. Push down 
miniSD Card cover until it clicks.

Note: Do not insert any object except a miniSD Card into the miniSD 
Card pocket.
Do not place labels, etc., onto the miniSD Card. A fine difference 
in card thickness may result in insertion or removal difficulty, loss 
of contact or loss of data.
Take care not to scratch or bend miniSD Card and gold contacts.

MiniSD Card

MiniSD Card
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PHONE OVERVIEW
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KEY FUNCTIONS
Key Function

Power Key
Press and hold to switch phone on or off.
Press to choose different ringtones, eject miniSD Card, lock 

keypad, or lock the phone.

Navigation Key
Press outside edges to scroll up , down , left  or right  

to move through menus and text. 
Press centre  to select option.
In standby mode, press centre  to enter main applications 

menu area.
Take a picture in Camera mode by pressing .

Send Key
Make a call.
Press in standby mode to recall recently dialled numbers. 

Scroll  to see received and missed calls lists.
Press and hold in standby mode to activate voice commands.

End Key
Ends a call.
Return to standby mode.

Applications Key
Enter the main applications menu area.
Return to standby mode.
Press and hold to view currently open applications.

Left Softkey
Perform action named in lower left of display.
Shortcut to open preset application in standby mode. To 

change shortcut, see Standby Mode Settings on page 117. 
To lock the keys, in standby mode press , then press .  

To unlock the keys, press , then press .

Right Softkey
Perform action named in lower right of display.
Shortcut to open preset application in standby mode. To 

change shortcut, see Standby Mode Settings on page 117.
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Edit Key
Select Dictionary for predictive text including insert and edit 

words, or alpha mode or number mode.
Insert numbers or symbols. 
Change writing language. 
Mark multiple items in a list by holding down , then 

scrolling  or .

Clear Key
Erase character in edit mode.
Delete highlighted entered item.

Browser Key
Opens Browser.

Asterisk Key
In standby mode, press and hold to switch Photolight or 

flashlight on or off.
In numeric and standby modes, press repeatedly for *, +, p 

and w characters.
In Dictionary mode, scroll to other word choices when word is 

underlined.
In edit mode, press to open special character table.

Zero Key
In standby mode, press and hold to enter + character for 

dialling.
In edit mode, enter space.

Silent Mode Key
In standby mode, press and hold to switch Silent mode on or 

off.
In edit mode, shift to upper and lower case letters, or press 

twice briefly to turn on/off Dictionary for predictive text.

Multibutton (on side of phone)
From external display, turns on backlight for 15 seconds or if 

backlight is already on, brings up status icons.
Turns off ringer during incoming call.
Takes a picture when flip is closed.

Key Function
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Symbols used in this manual   

Press Power key. Press Applications key.

   Press outside edges of 
navigation key to scroll 
up, down, left or right to 
move through menus and 
text.

Press navigation key 
centre.

Press Send key. Press End key.

Press Left softkey. Press Right softkey.

Press Edit key. Press Clear key.

 - Press number keys. Press Browser key.

Press Asterisk key. Press Silent Mode key.

Press Multibutton key (on 
side of phone).
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ICONS
Different icons appear depending on the features you are using 
and the options you have selected.   

Icon Indicates Icon Indicates

Seven levels indicate 
battery charge level. Bars 
scroll when battery is 
charging.

Alarm is set

Seven levels indicate 
signal strength from 
network on which phone is 
currently registered

New voice mail message 
received (if you have 2 
lines, left circle is darkened 
for line 1, right circle is 
darkened for line 2)

GPRS service is available New message received

GPRS service is on hold 
during voice call

Message in Outbox waiting 
to be sent

GPRS connection is active Bluetooth® is enabled

Multiple GPRS connections 
are active Bluetooth® is active

Missed call Infrared is enabled (flashes 
when active)

Call divert is active (if you 
have 2 lines, 1 or 2 also 
appears)

USB connection enabled

Line selection 2 
(SIM card dependent, if you 
have 2 phone lines)

Navigation key - scroll and 
move up or down options

Data call
Navigation key - scroll left 
or right, move left or right to 
view tabs
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Keypad is locked
All ringing tones/ring 
volume are off (Silent 
ringtone)

Earpiece sound on Private handsfree headset 
attached

Loudspeaker sound on

Icon Indicates Icon Indicates
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STANDBY MODE DISPLAYS 

MAIN DISPLAY

EXTERNAL DISPLAY
Press Multibutton once to switch on backlight, then press as 
needed to toggle between clock and icon views.

                                           

Time
Network that phone is 
currently using

Battery charge 
level icon

Date

Right Softkey 
selection area

Signal strength
icon

Wallpaper

Left Softkey
selection area

Phone Status 
icon area

Time and date 
area

Battery charge level 
icon

Network that phone is
currently using

Signal strength
icon

Network Status 
icon area



   15

PHONE BASICS AND MANAGING 
CALLS
SWITCHING THE PHONE ON AND OFF
Press and hold .

MAKING CALLS
Check that phone is switched on, signal strength icon displays at 
least one bar , and your network operator logo displays before 
dialling a call.

Type in the Phone Number to Dial
1. From standby mode, enter the area code and phone number, 

and press .
2. To end the call, press .    

Use a Contact Card to Dial
From Contacts application:
1. Scroll to desired name card, press .

• If the card has several phone numbers stored, select the 
one you wish to dial.

To add information to your Contacts, see page 35 .

Note: If your SIM card is PIN protected, your PIN code will be 
requested. Enter the PIN code and press OK. See Security 
Settings on page 122.

Note: To erase a digit, press .
During a call, scroll  or  to adjust earpiece volume.

Warning: Closing the flip during a call DOES NOT END THE CALL, 
when set to default. Opening the flip again allows you to 
return to your previous conversation. To set the phone to end 
the call when you close the flip, see Active clamshell in Call 
Settings on page 117.
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Use a SIM Directory Entry to Dial
From Contacts application:
1. Scroll  to SIM directory view.
2. Scroll to desired name, press .

To add names and numbers to your SIM directory, see page 35.

Speak the Name to Dial
To dial by saying the name of the person you wish to call: 
1. Press and hold . 
2. After the prompt to “Say a command”, say “Voice Dial”.
3. After the prompt to “Say the name or number”, say the full 

name of a person in your Contact list, including first name and 
last name.

4. The name is repeated, and the phone will begin dialling.

See page 132 for more Voice Command options.

Speed Dialling
If you assigned speed dialling keys (see page 131) to your 
frequently called numbers, you can dial them with 2 key presses.
1. From standby mode, press the preset speed dial digit key  

-  then press .
• If Speed dialling is set to On (see Call Settings on 

page 117), just press and hold the preset speed dial digit 
key to dial the assigned number.

Dialled Numbers, Received, or Missed Calls List
You can quickly dial previously dialled numbers, received call 
numbers, or numbers of calls you missed.
1. From standby mode, press .
2. From the list of Dialled numbers, scroll to desired entry and 

press  to dial.

Note: Location number 1 may be reserved for voice mailbox number.
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• Scroll  to move to Received calls tab and Missed calls 
tab to select a number from either of those lists.

Automatic Redial
If you set Automatic redial to On in the Call Settings menu (see 
page 117), your phone will automatically redial the number up to 
10 times under certain conditions, such as no answer, destination 
number is busy, network busy, or some connection errors.
Press Quit or  to stop automatic redialling.

Dial from Messages
If a received message contains a phone number, you can dial it 
from the Inbox message. You can also call the sender of an SMS 
text message.
From Messages application:
1. Open Messages. Scroll to Inbox and open.
2. Scroll to desired message and open. 
3. To find the phone number within a message, press Options 

and select Find > Phone number, E-mail address, or Web 
address. When found, text and numbers will be underlined.
• To call the sender of SMS text message from the open 

message, press  to dial the sender’s phone number.

International Calling
From standby mode, press and hold  to enter +, the 
international prefix, which is a shortcut for international dialling 
access. Then type in the country code, area code, and phone 
number. Press . 

Emergency Calls
Dial the local emergency number used in your current location.

Note: Many countries/regions include an initial 0 in the area code. In 
most cases, you should omit this when dialling international 
numbers. For further help, contact your wireless service provider.
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1. Switch on the phone if it is off.
2. Verify that the antenna icon is displayed.
3. Enter the local emergency number (such as 112) and press 

. 

Send Service Command to Network
Ask your wireless service provider to activate a particular service 
by sending a service command. These commands, which may be 
called USSD commands, can activate services such as mobile 
prepay and chat.
1. First, contact your wireless service provider for the proper 

service command code.
2. Type in the supplied service command code. If the phone 

recognises it as a supplementary service or USSD request, 
press Send service comm.

ANSWERING CALLS
When there is an incoming call, the phone rings and flashes 
green.

1. Open flip to answer a call.
• If flip is open, press  to answer a call.

Mute Ringing Tone
To mute ringing tone, press  if flip is closed. If flip is open, press 
Silence . Then answer the call by pressing .

Change Answer Settings
To change the setting so a call will not be answered by opening 
the flip, see Active clamshell in Call Settings on page 117. 

Note: You can call the local emergency number even if the keys are 
locked.
Making emergency calls without SIM is country or network 
operator dependent.

Note: If the phone is set to a ringtone with vibrating alert on, the phone 
flashes green and vibrates instead of ringing.
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To answer by pressing any key except , , or , see 
Anykey answer in Call Settings on page 117.

Divert Incoming Calls
To divert calls to your voice mailbox or another number, see Call 
Divert on page 126. Then you can press   or Reject softkey 
and incoming calls will be diverted.  
If you ignore the call by not pressing any keys, the call details 
appear on the Missed calls list.

ACTIVE CALL OPTIONS
When on a call, you can put the call on hold, mute the 
microphone, send touch tones for passwords, etc., and create 
multi-party calls, depending on network support.

Place Calls on Hold
To put a call on hold or release the call from hold, press Options 
and select Hold or Unhold.

If you are connected to 2 calls (an active call and a call on hold), 
press Options and select:   
Swap Put active call on hold and activate held call.
Transfer Connect an active call and a held call, or an 

incoming call to an active or a held call, and dis-
connect yourself from both calls, leaving the two 
callers to talk to each other.

Shortcuts: You can also press  to switch between Hold and 
Unhold on one call, or switch between one active and one 
held call (Swap). 
To end a held call and continue with the active call, press 

 and .
To end the active call and continue with the held call, press 

 and .
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HANDSFREE TALKING
To hear the caller’s voice from the handsfree loudspeaker, press 
Loudsp.. Set the phone down nearby so you and several others 
can have a conversation without holding the phone. 
To go back to the earpiece, select Handset.

If you have activated a Bluetooth® handsfree headset, press 
Options and select BT Accessory to hear the caller’s voice in 
the Bluetooth® headset.

Volume Control
Scroll  or  to increase or decrease volume of phone earpiece 

, phone loudspeaker , or if a headset is attached. Note the 
volume step bars change as you adjust volume.
To mute or unmute the microphone, press Options and select 
Mute or Unmute. Mute switches off the phone’s microphone and 
any accessory microphones if attached. Unmute switches 
microphone back on.

CALL WAITING
If you activated Call waiting network service in Call Settings (see 
page 117), you can answer an incoming call when on an active 
call.
1. During an active call, press  to answer an incoming call. 

The active call is put on hold.
• To switch between the calls, press Swap or .
• To end the currently active call and answer the incoming 

call, press Replace.
2. To end the currently active call, press . The held call 

becomes active.
• Or to end both calls at once, press Options and select End 

all calls.

Loudspeaker icon - handsfree is active.

Earpiece icon - handsfree is not active.
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• If you press and hold , all calls and data connections 
are ended.

To reject the incoming call, press Reject. The caller receives a 
busy message or goes to voice mail.

Send DTMF Touch Tones
DTMF touch tones can be transmitted during a call just by 
pressing the keys (0 to 9, #, *) on your phone. Touch tones are 
often used to access services such as voice mailboxes, calling 
card calls, and banking. 

During a call, press Options and select Send DTMF if you stored 
a DTMF touch tone sequence in a Contacts card. Press Find, 
scroll to desired entry and select. 

To dial or store touch tone sequences:
1. Type in access phone number.
2. Before entering touch tone digits, press  repeatedly to 

scroll through *, +, p, and w characters to:
• a short pause before the digits are transmitted (p 

character).
• a manual wait period (w character) that requires you to 

press Send  during the call to transmit the digits.
• + character to send a touch tone sequence stored in a 

speed dial location (see page 131).
3. Enter the touch tone digits, for example, the access codes for 

your voice mailbox.
4. Press  to immediately dial call, or press Options and 

select Add to Contacts to store sequence in your Contacts 
(see page 35).

Open Applications during a Call
During a call, open the main application menu by pressing , 
then open the desired application, for example, check your 

Note: You can enter multiple instances of pause, wait, and speed dial 
characters and touch tone sequences.
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Calendar for an upcoming meeting time. The active call remains 
connected and is indicated by a small pop-up window. To return to 
the active call window, exit the application.

If you press , an active call will always disconnect.

Play/Record Sound Clips during a Call
To play a sound clip during a call, open the sound clip from its 
current location and play. The other person hears the sound clip.
To record the current call, see page 141.

Multi-Party Calls
In a multi-party call, you can have a conversation with up to 5 
different parties at the same time if supported by the network.
1. Call the first party.
2. After the call is connected, press Options and select New 

call to enter a number or press Find to go to the Contacts to 
dial a number and press . The first call is put on hold.

3. After the new call is answered, press Options and select 
Conference to join the held call and the active call together. 
From then on, there is only one active call, which is the multi-
party call.

4. To add another party to the call, repeat step 2, then press 
Options and select Conference > Add to conference.

5. To have a private conversation with one of the parties, press 
Options and select Conference > Private. Scroll to desired 
party and press Private. The separated party becomes the 
active call on your phone, the multi-party call is put on hold; 
however, the remaining callers can continue with the multi-
party call. To return to multi-call, press Swap. To return 
Private call to multi-call, press Options and select 
Conference.

6. To drop a party from the multi-party call, press Options and 
select Conference > Drop participant.  Scroll to desired 
party and press Drop. 
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7. To end the multi-party call, press . 

ENDING CALLS
There are several ways to end a call:

• Close the flip.
• Press .
• Press End call softkey.
• Press Options and select End active call.

To end all calls if there are more than one:
• Press Options and select End all calls.

If you press and hold , all calls and data connections are 
ended.

See Active Call Options starting on page 19 for ending held calls, 
waiting calls, and multi-party calls.

CLOSE THE PHONE DURING A CALL
Closing the flip clamshell ends the call. This is the default setting 
for Active clamshell in Call settings. If you want to close the 
phone and speak handsfree during a call, change the Active 
Clamshell setting to Off. This setting switches the caller's voice 
to the back loudspeaker so you can speak handsfree.
To keep calls connected when you close the flip clamshell and 
prevent calls from being answered when the flip is opened, see 
Active clamshell in Call Settings on page 117.

Note: If you are on an active call and already have a held call, start at 
step 3.
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ENTERING TEXT
There are two main ways to enter text: using the predictive text 
dictionary to quickly enter words, or alpha mode in which each 
key is tapped until the planned letter appears.

DICTIONARY FOR PREDICTIVE TEXT ENTRY
Dictionary uses a predictive text system to enter words by 
pressing one key per letter to display the planned word, instead of 
pressing keys multiple times until each planned letter appears. 

For example, to enter “Call me.” in a message, press:

                
C a l l m e .

When you press the 6 key and the 3 key, the word “of” appears on 
screen, because the English dictionary ranks “of” as the most 
common word associated with the key presses 6 and 3. To 
change the word “of” to “me”, press  once, and the word 
changes.

DISPLAY PLANNED WORD MATCHES
If the correct word does not display, press  repeatedly to 
scroll through an alternative word list. To choose from all the word 
matches, press  and select Dictionary > Matches.

ADD WORDS TO PREDICTIVE TEXT DICTIONARY
To add a word that is not already in the dictionary, press  and 
select Dictionary > Insert word. You can also add the word to 
the dictionary when Spell softkey appears.

GENERAL TEXT ENTRY
Enter text and numbers in one of three ways: 

Alpha mode - press each key repeatedly until planned 
letter appears.
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Dictionary mode - press one key per letter for dictionary to 
display planned word.

 Numeric mode - enter numbers.

In both alpha mode and dictionary mode, choose from:
First letter capital All capitals
Lower case

To enter symbols, press  and select Insert symbol.

To enter text at a flashing cursor:
1. Press the number keys associated with the planned letters 

repeatedly until the planned letters appear on screen. 
• To enter text using the predictive text dictionary, press  

and select Dictionary on, if it is not already active.
2. Editing actions for each key and shortcuts:

Shortcut: To enter numbers while in alpha or dictionary mode, press 
and hold desired number key  - .

Enter space.

Enter punctuation by pressing repeatedly.
In Dictionary mode, press , then press  repeatedly to 

scroll to other punctuation.
Erase a character.

Press and hold to switch between text and number modes.
Press to scroll through upper case, lower case, and first let-

ter capital mode.
Press twice briefly to turn Dictionary on or off.
Turn Dictionary on or off.
Switch to number mode.
Insert symbols.
Change writing language.
In Dictionary mode, scroll to other word choices when word 

is underlined.
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Cut, Copy, and Paste Text
1. To cut, copy, and paste text, move cursor to left of text you 

wish to copy. 
2. While holding down , press and hold  to highlight text.
3. Release keys to stop highlighting. 
4. Press  and select Cut or Copy. 
5. In message field, move cursor to new desired location, press 

 and select Paste.

Press outer edges to scroll up, down, left, and right through 
text.
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NAVIGATING THE APPLICATIONS
To view the main applications window, press .

Navigation Key
Press the left, right, top and bottom edges of the navigation 
key to move around the display. 

Press  to:
• Open an application item
• Select a highlighted item
• Confirm a selection
• Take a picture with the camera

If an up or down arrow appears at the bottom of the display, scroll 
 or  to go to additional items.   

Tabs
There may be more files, folders, or pages 
associated with an application item, which 
can be viewed by moving right and left 
across the screen. This is indicated by tabs 

, arrows , or numbers near 
the top of the screen.  For example, if you 
are viewing page 5 of 12 pages associated 
with a file, 5/12 and arrows are displayed.
• Scroll  and  to move through the tabs 

and pages. 

Shortcut: To jump to and open one of the first 9 application items (if you 
have not yet scrolled), simply press the number key 
corresponding to the desired item’s location on the grid view. 
The grid view numbering system is: 

1 2 3

4 5 6

7 8 9
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Condensed Instructions
In this guide, to condense wording, statements are used such as 
“Press Options and select Open”. This means to press Options, 
highlight Open, and press Select. You may need to scroll within 
the menu to reach Open. Many menu items are available within 
Options menus and other menus; thus these shortcut statements 
will be used throughout the guide to indicate the same type of 
process.

In this guide, a statement such as “Select Send > Via 
multimedia”, means to scroll to Send, then scroll  to view the 
pop-up menu containing Via multimedia, then press  or Select 
softkey to select Via multimedia. Within the pop-up menu, you 
may need to scroll to highlight Via multimedia.

Options Softkey
At the first level of each menu item, Options  appears as a 
way to organise or customise the menu system. The options 
change depending on the menu level you are viewing.

To open the Options menu:
• Press Options, scroll to highlight the desired action, then 

press  or press Select. 

Open Open the item.
List view View the menu items in a list form. If you select 

this, the option changes to Grid view to view the 
menu items in a grid form.

Move Move the item to another place within the 
application system.

Move to folder Move the application item into a folder.
New folder Create and name a new folder.
Memory 
details >

View information about items stored in the phone 
memory and memory card (also referred to as 
miniSD Card).

Exit Exit the menu item.
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These additional actions may be available in the Options menu:

Mark/Unmark
In menu items containing many files, you can mark specific files in 
which to perform an action. For example, you may wish to delete 
5 images from your Images folder containing 29 images.

To mark an item or items:
1. Press Options and select Mark/Unmark > Mark to place a 

checkmark next to the desired file. Scroll to mark more items 
as needed, or select Mark all to mark all files.

2. Press Options, then select desired action such as Delete, 
Send, Move.

To unmark an item or items:
1. Press Options and select Mark/Unmark > Unmark on a 

marked file to remove the checkmark. To unmark all files, 
select Unmark all. 

Remove or 
Delete

Remove or delete an item or a marked item (see 
Mark/Unmark on page 29) on a list or grid, or 
press .

Rename Give a new name to the item.
Edit Change information you have already entered.

Shortcuts: To mark or unmark an item, hold down  then press .

To mark or unmark multiple items, hold down  then 
press and hold  or  of navigation key to scroll through 
desired items. Release  or  to stop marking.
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Menus within a Menu
A pop-up menu appears when more than 
one choice is available. For example, you 
can send a Contacts entry several ways: via 
text message, via multimedia, via e-mail, via 
Bluetooth®, and via infrared. 

To enter a pop-up menu:
• Scroll , or press , or Select softkey.

To close a pop-up menu:
• Scroll , or press Cancel softkey.

Save Changes
In many cases when editing text or numbers, or changing a 
setting; press the Back softkey to automatically save changes.

MULTITASKING
You can work with more than one menu item simultaneously. For 
example, you can start creating a new message, rename an 
image, and begin creating a Contacts entry, all without losing the 
data you have already entered.

To keep a menu item open:
Press  to go to the standby screen. Pressing  does not 
close the open menu item. 

Opening and closing menu items
There are several ways to open menu items:
• Press .
• Press Options and select Open.

There are several ways to close menu items:
• Press Options and select Exit.

Note: During a phone call,  terminates the call instead of acting as 
a shortcut to the standby screen.
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• Press Back until Exit softkey appears, then press Exit.
• Press Close.

Shortcut to swapping among open items
If you have several menu items open, you 
can press and hold  to view a pop-up 
window and scroll to locate the desired open 
item. When you open the item, you will begin 
at the point where you were previously.
To close an open item from the pop-up 
window, scroll to desired item, press  
and select Yes.

SEARCH OPTION
In certain menu items, a magnifying glass icon  
appears which allows you to search for a name, file or item.
To search, enter the first letter of the desired name or file. The 
phone finds and displays matching entries. To refine the search, 
enter two or more letters.

SHARED PHONE MEMORY
The phone’s memory capacity is shared by all images; text, 
multimedia and e-mail messages; Contacts cards; video and 
sound clips; ringtones; Calendar and Notepad notes; and 
downloaded applications stored on your phone. If you keep more 
files on the phone, then there is less memory available to store 
new files or run certain applications.
To decrease the amount of phone memory used: (1) store data on 
your miniSD Card; (2) delete data that is old, copied elsewhere or 
not being used; (3) delete messages with attachments from your 
Inbox after saving attachments to an application; (4) use the 
portrait format to take pictures with the Camera whenever 
possible. The portrait format file size is much smaller than 
standard format.
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To view details of the phone memory and miniSD Card use, and 
amount of free memory: 
1. Press .
2. Press Options. 
3. Scroll to Memory details.
4. Then scroll   to chyoose phone memory or memory card 

(also referred to as miniSD Card). 
Also see File Manager on page 148.
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APPLICATIONS MENU MAP
The phone’s main application menus are listed below. The names 
listed represent the names in list view. The names may be slightly 
different in grid view.      

Note: The menus may not appear in the order or with the same icons as 
listed here. The order and icons vary according to your wireless 
service provider, or if you have customised your settings.

  Settings   Camera   Tools
Ringtone 

Profiles
Themes
Settings
Clock
Speed Dialing
Voice Cmds
PrintBoy Setup
About product

Calculator
Converter
Notepad
Voice recorder
miniSD Card
To-Do List
Application 

Mgr
File manager
PhotoLight
SIM Tool Kit 

(optional)

  Calendar   Contacts   Media
Media Gallery
PhotoBase
RealOne 

Player
Video 

Recorder
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  Messages    Call Logs   Connectivity
Voice Mailbox
Messages

Recent calls
Call duration
GPRS 

counter

Browser
Operator 

Menu
Modem
Bluetooth
Infrared
USB
Connection 

Mgr
SyncML
Device Mgr

  Games   Favourites  Quickoffice
Micro Golf
Balloon-

Headed Boy
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CONTACTS
Store names, phone numbers, e-mail, web and street addresses, 
even a thumbnail picture in a Contact card. Call and send 
messages directly from Contacts. Numbers can also be stored on 
your SIM card. See Entering Text page 24 to learn how to enter 
text.

CREATE NEW CONTACT CARDS
From Contacts application:
1. Press Options and select New contact.
2. Enter information in main fields:

First name Telephone
Last name Mobile
Company Fax
Job title E-mail

3. From main fields, press Options to: 

4. Press Done to save entry.

SIM DIRECTORY
The SIM Directory shows you the names and numbers stored on 
your SIM card. Your wireless service provider can program their 
service numbers, your wireless phone number and other numbers 

Add thumbnail Place picture from your Images folder into the 
card.

Add or Delete 
detail

Choose desired fields and icons from list including 
Job title, Telephone, Tel. (home), Tel. (business), 
3 mobile, 3 fax, pager numbers, 3 E-mail fields, 3 
Web addresses, 3 street address fields, DTMF 
tones, Birthday, and Note.

Edit label Change the field name.

Note: See SIM Directory to create and copy entries into your SIM 
Directory.
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into your SIM card. You can store personal numbers on your SIM 
card as well. 

Unlike a Contacts entry, a SIM Directory entry consists of only one 
name and one phone number.

Copy Numbers to SIM Directory
1. From the Contacts list, highlight the desired card.
2. Press Options and select Copy to SIM direct.
3. Choose one of the phone number fields to copy, and press 

OK.
• If you select All, the phone creates a separate SIM 

directory entry for each phone number stored with that 
Contacts entry name.

Create and Manage SIM Directory Entries
1. From the Contacts list, scroll  to SIM directory tab.
2. Press Options and select from:    

Note: To copy SIM entries to your Contacts, highlight the desired SIM 
entry, then press Options and select Copy to Contacts.
The first time Contacts is opened after a different SIM card is 
placed in the phone, press OK if you wish to copy SIM contacts 
into the Contacts memory.

Call Call the highlighted entry.
New SIM con-
tact

Create a new SIM contact entry. Open and enter 
Name, then enter No. and press Done.

Edit Edit the highlighted SIM entry. Numbers stored by 
your wireless service provider cannot be edited.

Delete Delete the highlighted SIM entry. Numbers stored 
by your wireless service provider cannot be 
deleted.

Copy to Con-
tacts

Copy the highlighted SIM entry to your Contacts 
list.

My numbers View your own phone numbers.
SIM details View the number of used and free SIM entries.
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FIND A CONTACT CARD
From Contacts application:
1. Scroll to desired entry, or enter the first letter of desired entry 

in . Entries beginning with that letter will display.
2. Press  to open entry.

MAKE A CALL
From Contacts application:
1. Scroll to desired Contacts entry and press .

Or, press Options and select Call.
• If entry contains more than one number, choose desired 

number to dial before pressing . 

CREATE A MESSAGE
From Contacts application:
1. Scroll to the desired Contacts entry and press Options.
2. Select Create message > Text message, Multimedia 

message, or E-mail.
3. To complete Text messages, see page 50; or Multimedia 

messages on page 51; or E-mail messages on page 53.

EDIT CONTACT CARDS
From Contacts application:
1. Highlight desired Contacts card.
2. Press Options and select Edit.
3. Scroll to desired field to edit, and begin entering data. If the 

field already has information, scroll  to move to editing point, 
and press  to clear a letter or digit.

Note: To make a call from the SIM directory, from Contacts application 
scroll   to SIM directory tab. Scroll to the desired entry and 
press .
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4. Press Options to:

5. Press Done to save entry.

Assign Default Number to Dial
For a Contact card, set a particular phone number or address that 
the phone will use each time you wish to call or write messages to 
that person.
From Contacts application:
1. Scroll to desired Contact card and open.
2. Press Options and select Defaults.
3. Highlight a field:

Phone number
Text msg. number
MMS number/address
E-mail address

4. Press Assign.
5. Scroll to the desired entry and press Select.

• Repeat steps 4 to 6 to assign default numbers to the other 
fields.

Assign a Ringing Tone
From Contacts application:
1. Scroll to desired Contact card and open.
2. Press Options and select Ringing tone.

Add thumbnail Place picture from Images folder in phone mem-
ory or miniSD Card.

Add or Delete 
detail

Choose desired fields and icons from list including 
Job title, Telephone, Tel. (home), Tel. (business), 
3 mobile, 3 fax, pager numbers, 3 E-mail fields, 3 
Web addresses, 3 street address fields, DTMF 
tones, Birthday, and Note.

Edit label Change the field name.

Note: To remove a default assignment, select (no default).
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3. Scroll to desired tone (after a brief pause tone will play). You 
can use tones already supplied, sent in messages (see 
page 56), downloaded (see page 95), or recorded (see 
page 140).   

To assign a ringing tone to a group, scroll  to move to Groups 
tab, scroll to desired group, and continue with step 3.

Assign Speed Dial
From Contacts application:
1. Scroll to desired Contact card and open.
2. Scroll to desired phone number field in which to assign the 

speed dial key, press Options and select Assign speed dial.
3. Press or scroll to desired number key and press Assign. The 

icon  denotes that a speed dial key has been assigned to 
this number field.

To make a call using speed dial, press the associated number 
key, then press .

To remove an existing speed dial key, from Contacts application:
1. Scroll to desired Contact card and open.
2. Scroll to speed dial phone number field, then press Options 

and select Remove speed dial.
See page 131 for speed dial options.

Go to Web Address
If a Contact card contains a web address, you can launch the 
Browser and go directly to the web address.
From Contacts application:
1. Scroll to desired Contact card and open.
2. Press Options and select Go to web address. 

Note: If tones do not play, change the phone's ringtone to General or 
Outdoor to hear the tones.
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MANAGE CONTACTS LIST
From Contacts application:
1. Press Options and select Edit, Delete or Duplicate.

Memory Used in Contacts
To view number of cards, groups used and amount of memory 
used, from Contacts application:
1. Press Options and select Contacts info > Memory.

Sort List by Last Name or by First Name
From Contacts application:
1. Press Options and select Settings.
2. Open the Name display field to sort the list either by Last 

name first or First name first.

SEND A CONTACT CARD
Before a Contact card can be sent by Messaging or to another 
device, it is converted to an electronic business card format 
known as vCard.
From Contacts application:
1. Scroll to desired Contact entry.
2. Press Options, scroll to Send > Via text message, Via 

multimedia, Via e-mail, Via Bluetooth, or Via infrared.
3. To complete text messages, see page 50; or multimedia 

messages on page 51; or e-mail messages on page 53; or 
Bluetooth® on page 102; or Infrared on page 104.

SERVICE NUMBERS
If your wireless service provider has stored service numbers on 
your SIM card, you can view and call the service numbers.
From Contacts application:

Note: See Mark/Unmark on page 29 to select more than one entry. 

Note: This feature is not available if the phone contains Chinese 
language. 
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1. Press Options and select Service numbers.

CREATE AND MANAGE GROUPS
Place Contact entries into one group. Select the group name 
when addressing a new message, and your message is sent to 
each member of the group. For example, set up Business or 
Family group. See Messages starting on page 48 to learn how to 
send messages.

Create New Group
From Contacts application:
1. Scroll  to Groups tab.
2. Press Options and select New group.
3. Enter a name for the group and press OK.
4. Open the group name, press Options and select Add 

members.
5. Select desired Contact cards to add.

• To remove a member from a group, scroll to desired name, 
then press Options and select Remove from group.

Manage Groups
From Contacts application:
1. Scroll  to Groups tab.
2. Scroll to desired group, then press Options and select from: 

Open to view group, Delete group, Rename group, add 
Ringing tone for group.

To see if a person belongs to a group, or to add a person to a 
group, from Contacts application:
1. Scroll to desired Contact card.
2. Press Options and select Belongs to groups or Add to 

group. When adding, select desired group and press Add.
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TAKE A PICTURE AND ADD TO CONTACT 
CARD
From Camera application:
1. The main display acts as a viewfinder when the flip is open. 

The external display acts as the viewfinder when the flip is 
closed.

2. To snap the picture, press  if the flip is open. Or press the 
Multibutton  on the side of the phone if the flip is closed.
• The image is saved in your Images folder in Media Gallery.

3. Open Contacts.
4. Highlight desired Contacts card.
5. Press Options and select Edit.
6. Press Options and select Add thumbnail.
7. Select Phone memory.
8. Open Images folder. Scroll to highlight the image, and press 

Select.
9. Press Done.
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CALENDAR
Keep track of upcoming meetings, appointments and special 
dates. Set alarms to remind you of upcoming events. Calendar 
events can be sent and received as vCalendar messages and 
synchronised with other devices to keep track of your schedule.

CREATE CALENDAR EVENTS
From Calendar application:
1. Press Options and select New entry > Meeting - events with 

a start and end time, Memo - events such as trips or 
vacations, or Anniversary - single day events such as 
birthdays and anniversaries.

2. Enter information in most fields by entering numbers or letters:

3. Press Done to save event.

Set Calendar Alarm
When you set the alarm to On, scroll  to set the alarm time and 
date.
When the alarm rings, press Stop  to stop the alarm. Press 
Snooze  or any other key to snooze the alarm. 

Meeting Memo Anniversary
Subject Subject Occasion
Location Start date Date
Start time End date Alarm
End time Synchronisation Synchronisation
Start date
End date
Alarm
Repeat
Synchronisation

Shortcut: If you start typing after opening the Calendar, you are 
automatically entering the subject in a Meeting entry.
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Set Event Repeat Cycle
When an event occurs regularly (for example, football practice or 
music lessons), open the Repeat field to set interval time periods 
such as Weekly or Monthly.

Set Synchronisation
If you synchronise your Calendar events with a PC, you can set 
the privacy level.
• Set to Private to hide events from online viewers. 
• Set to Public to allow online viewers to see the event.
• Set to None if you do not wish to synchronise the event with 

your PC calendar. See Synchronisation on page 107.

BROWSE CALENDAR
View the calendar by day, by month, or by week.
To change view, press Options and select Month view or Week 
view.

CALENDAR ICONS
 Meeting Memo Anniversary

Month View
Scheduled event - triangle in the lower right 
corner of a date.
Current date - underlined. 
Selected date - boxed; date also appears in 
the navigation bar.
Far left column - the year’s week number (see 
Week view title in Settings).

Shortcuts: Scroll     to move around the calendar.
Press Options and select Go to date to go to a desired 
date.
Press  to go to today.
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Week View
Days of the week are displayed in columns. 
Each hour of a day is denoted by a cell.
Meeting events - a colour bar during the 
scheduled time periods.
Memo and Anniversary icons - appear 
between 7am and 8am
Current weekday - underlined (if you are 
viewing the current week).
Selected date - boxed; date also appears in the navigation bar.
Screen title - either the week number or the week dates of the 
current week, depending on Calendar setting.

Day View
To view a certain day, scroll to the date and 
open.
Scheduled events are listed.

EDIT CALENDAR EVENTS
1. Scroll to desired date in any view and open.
2. Scroll to scheduled event and open. Edit desired fields.
3. Press Done when finished.

DELETE EVENTS
1. Scroll to desired date in Month or Week view, and time period 

in Week view and open.
2. Press Options and select Delete or press .

To delete multiple events:
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1. View the calendar in Month view.
2. Press Options and select Delete entry > Before date to 

delete entries before your specified date, or All entries.

CALENDAR SETTINGS
From Calendar application:
1. Press Options and select Settings. Open each option:  

SEND CALENDAR EVENTS
Before a Calendar event can be sent by Messaging or to another 
device, it is converted to an electronic scheduling exchange 
format known as vCalendar.
1. From an open Calendar event in Day view, press Options 

and select Send > Via text message, Via multimedia, Via e-
mail, Via Bluetooth or Via infrared.

2. To complete text messages, see page 50; or multimedia 
messages on page 51; or e-mail messages on page 53; or 
Bluetooth® on page 102; or Infrared on page 104.

Calendar alarm 
tone

Scroll to select desired tone (after a brief pause 
tone will play).

Default view Select Month view, Week view, or Day view.
Week starts on Choose starting day of the week.
Week view title Choose Week number of the year (e.g. Week 12) 

or Week dates (e.g. 20.03.05-26.03.05). 

Note: Week view title setting is available only if Week starts on is set 
to Monday. Week numbers are shown in layouts only if Week 
starts on is set to Monday.
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CHINESE LUNAR CALENDAR
Check Chinese Lunar Calendar dates and festivals when still 
viewing western Calendar information.

To display Chinese Lunar Calendar information:
1. From the open Calendar, press Options and select Settings.
2. Scroll to Lunar Calendar. 
3. Select On.
4. To view Chinese Lunar Calendar detail, press Options and 

select View lunar data.

To turn off Chinese Lunar Calendar information:
1. From the open Calendar, press Options and select Settings.
2. Scroll to Lunar Calendar.
3. Select Off.   

Note: Chinese Lunar Calendar will appear only when a Chinese 
language is selected as the phone display language.
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MESSAGES
Messages menu contains these main options:

VOICE MAIL
Voice mail service stores voice messages from callers who could 
not reach you. The messages are stored on your wireless service 
provider’s network, not on your phone. You must first subscribe to 
voice mail from your wireless service provider before using this 
service.

Listen to Voice Mail Messages
When you receive a new voice mail message, an alert sounds if 
ringtone is not set to silent, and the voice mail icon  displays.
1. Press and hold  in standby mode to dial your voice mail 

message centre.
• You can also press  and  in standby mode.

2. Follow the prompts to listen to your voice mail messages.

If the phone asks for the voice mailbox number, enter the voice 
mail message centre phone number given to you by your wireless 
service provider.

To change the voice mailbox number, from Messages application:
1. Open Voice Mail.
2. Press Options and select Change number.

MESSAGES
Send, receive, and store messages from text message (SMS), 
multimedia (MMS), e-mail, service and cell broadcast. 

Voice mail Messages
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Messaging Types
SMS: Short Message Service allows you to send and receive 
short text messages to mobile phones with short text message 
capability on the same network or any network that has a roaming 
agreement. A small black and white picture message can be 
inserted in the message.
MMS: Multimedia Messaging Service allows you to send 
messages containing images, video clips, sound clips and text. 
Presentation templates are available to place media objects into 
prearranged layouts. Multimedia messages can be sent to 
another mobile phone with multimedia capability or to an e-mail 
address.
E-mail: Create, send and receive e-mail messages, which can 
have attachments.
Smart messages: Messages containing data such as electronic 
business cards, ringing tones, Java™ applications or configuration 
data such as WAP and multimedia settings.

These services do not work by sending messages directly to the 
recipient; instead they store and forward messages through 
specifically designated network servers. 

Before Using Messaging Services
Before you can use multimedia or e-mail messaging, your 
connection settings must be configured. 
Your multimedia configuration settings may already be set by your 
wireless service provider. If settings are not available, contact 
your wireless service provider.
Your e-mail configuration settings are provided by an Internet 
Service Provider (ISP) that supports POP3/IMAP4/SMTP 
protocols. 
Before you can send and receive e-mail:
(1) you need a subscription for data services
(2) contract must be set up with an ISP
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(3) you must configure an Internet Access Point (see Access 
Point Settings on page 118) 

Messages Menu Main Options 

In some main Messages options, icons indicate the message 
type:

To view Cell Broadcast messages, see page 69.

CREATE NEW TEXT MESSAGES
From Messages application:
1. Open Messages.
2. Open New Message and select Text 

message.
3. In the To field, type in recipient’s phone 

number.
• To retrieve from Contacts card, press 

, or Options and select Add 

New message
Create new messages

Drafts
Stores unfinished messages

Inbox
Stores received messages except 
e-mail and cell broadcast

Sent
Stores sent messages

My folders
Stores moved messages and 
templates

Outbox
Temporarily stores messages 
waiting to be sent

Mailbox
Receives and stores e-mail 
messages

Reports
Delivery status on text, multimedia, 
and smart messages

Text message Bluetooth Cell broadcast

Multimedia Infrared Unknown

E-mail WAP push Attachment

Smart
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recipient. Scroll to desired name and press OK. Select 
desired number if entry has several numbers. 

• To separate multiple recipients, enter a semicolon (;) by 
pressing .

4. Scroll  to move to text entry field, and enter text. 
5. If desired, press Options and select Insert > 

6. To send, press  or press Options and select Send.

CREATE NEW MULTIMEDIA MESSAGES
From Messages application:
1. Open Messages.
2. Open New message and select 

Multimedia message.
3. In the To field, type in recipient’s phone 

number or e-mail address.
• To retrieve from Contacts card, press 

, or Options, and select Add 
recipient. Scroll to desired name and 
press OK. Select desired number if entry has several 
numbers. Card must have a phone number or e-mail 
address to be visible.

• To separate multiple recipients, enter a semicolon (;) by 
pressing . 

4. Scroll  to move to text entry field, and enter text. 
5. If desired, press Options and select Insert > 

Picture Picture msg. from Media Gallery
Template Select from a list of sentences in which you fill in 

the blank

Note: Text messages have a 160 character limit. The counter keeps 
track of total characters available. If you use more than 160 
characters, a new text message starts, but appears as one 
message or more at destination. You may be charged for more 
than one text message.

Image Image from your Images folder
Sound clip Sound clip from your Sound clips folder
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6. To send, press  or press Options and select Send.

Create Presentation
Choose from four presentation templates to create an impressive 
multimedia show.
1. Complete steps 1, 2 and 3 in Create New Multimedia 

Messages on page 51.
2. Press Options and select Create presentation.
3. Select from the list of templates:

• Image template
• Video template
• Sm. image tem.
• Temp. with title

4. Highlight desired template, and press Select.
5. Scroll to the video, text, or image region of the template to 

highlight it.
6. If desired, press Options and select Insert >    

Video clip Video clip from your Video clips folder
New image New image from Camera
New sound clip New sound clip from Recorder
Slide Add new slide to message

Note: If multimedia messages are sent to devices without multimedia or 
e-mail capabilities, the recipient may receive a message 
containing a link to a web page.

Image Image from your Images folder
Sound clip Sound to play at start of show
Video clip Video clip from your Video clips folder
Note Note from Notepad (if a text region is highlighted)
New image New image from Camera
New slide Add new slide to show

Note: Available choices depend on region highlighted.
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7. Press Options and select: 

8. To send, press  or press Options and select Send.

CREATE NEW E-MAIL MESSAGES
Before you can write an e-mail message, at least one mailbox 
must be configured. See page 58.
From Messages application:
1. Open Messages.
2. Open New message and select E-mail.
3. In the To field, type in recipient’s e-mail 

address.
• To retrieve from Contacts card, press 

, or Options, and select Add 
recipient. Scroll to desired name and 
press OK. Card must have an e-mail 
address to be visible.

• To separate multiple recipients, enter a semicolon (;) by 
pressing .

4. Scroll  to enter recipients in Cc (courtesy copy) field and 
type subject in subject field (both fields optional).

Send Send completed presentation
Full screen Edit in full screen view
Normal screen Edit in normal screen view with signal icon, slide 

number, and softkey labels in view
Edit text Start or stop text editing, change text colour
Preview 
message

Preview entire message before sending

Remove > Remove image, sound clip, video clip, or current 
slide

Backgrnd. 
settings >

Set background colour, add background image to 
current slide or entire presentation, remove 
background image

Effect settings > Set transition effect between images and between 
slides
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5. Scroll  to move to text entry field, enter text. 
6. If desired, press Options and select Insert > 

7. To send, press , or press Options and select Send.
• To view, add, or remove attachments before sending, press 

Options and select Attachments.
• If phone is set to send e-mail during next connection to 

mailbox, then pending e-mail will be stored in Outbox. 
Change setting by pressing Options and selecting 
Sending options.

COMMON WRITING TASKS
• To cut, copy and paste text, see page 26.
• To save before sending, press Close. Message is 

automatically stored in Drafts folder.
• To match names in To and Cc fields to names in Contacts, 

press Options and select Check contacts.

RECEIVE NEW MESSAGES
When you receive a new message, the standby screen displays a 
new message icon  and a note indicating the number of new 
messages. Press Show to read the message. If there is more 
than one message, press Show to open the Inbox, then scroll to 
the desired message header and open.

INBOX (RECEIVED MESSAGES)
Inbox stores received text, multimedia, and smart messages. 
Incoming Bluetooth®, Infrared, WAP push, SIM, voicemail and e-
mail waiting messages are also placed here.

Image Image from your Images folder
Sound clip Sound clip from Sound clips folder
Video clip Video clip from Video clips folder
Note Note from Notepad
Template Select from a list of sentences in which you fill in 

the blank
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The messages remain in the Inbox until you move them to My 
folders or delete them.

Unread messages have incoming arrow appearing with icon that 
identifies type of message.
Read messages have no arrow with icon.

Read or Play Inbox Messages
From Messages application:
1. Open Messages.
2. Scroll to Inbox and open.
3. A list of message headers displays, indicating type of 

message sender (Multimedia, Bluetooth®, etc.) and icon. 
Scroll to desired message header and open.

• The message may first need to be retrieved from the network 
server depending on the message type or whether it contains 
large files.

• Press Play if needed for video clips, sound clips and 
presentations.

• If the message contains an image, it opens automatically.

Reply to and Forward Inbox Messages
From Messages application:
1. Open Messages.
2. Select Inbox.
3. Scroll to desired message, press Options and select Reply  > 

To sender or To all or Forward.
4. To reply, enter text in text field.

To forward, enter recipient(s) phone numbers or e-mail 
addresses.

5. Press .

Note: Scroll  to decrease or increase audio volume.

Note: The phone may not allow you to copy, modify, transfer, or forward 
some copyrighted images, ringtones and other content.
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Store Inbox Messages
From Messages application:
1. Open Messages.
2. Select Inbox.
3. Highlight desired message.
4. Press Options and select Move to folder.
5. Choose a folder and press OK.

Save Attachment or Data
You can save images and media clips from messages. 
Attachments to e-mail, links to streaming media, Contacts cards, 
Calendar items, ringtones, and configuration data can also be 
saved.
1. Open desired message.
2. Press Options and select Save. 

• If needed, the data is directed to the appropriate 
application.

3. If needed, select to save either in phone memory or miniSD 
Card, and press OK.

4. If needed, scroll to desired folder to place object or 
attachment, press Open or Save. If desired, rename the file. 
Press Save.

Find Phone number, E-mail or Web Address in Message
Within received messages, you can find a phone number, e-mail 
or web address within message text and use it to call, write, 
access a service or create a Contacts card.
From Messages application:
1. Open Messages.

Note: Received applications or games can be installed directly from the 
Inbox. When you open the message, the phone asks if you want 
to install it now.
An attachment or object remains in the Inbox after it is saved to 
another application. To save memory space, delete message 
from Inbox.
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2. Scroll to Inbox or My folders and open.
3. Scroll to desired message and open. 
4. Press Options and select Find > Phone number, E-mail 

address, or Web address.
5. Text and numbers are highlighted when found. If more than 

one is found, scroll to highlight desired item.
6. Press  to Send a message, Add to Contacts to add or 

update Contacts, Call a number, Go to web address, or Add 
to bookmarks to add web address to bookmarks. 

MY FOLDERS (ORGANISE MESSAGES) 
Store your messages in My folders. You can also create and 
name new folders. For example, create a folder for Friends and 
one for Family messages. Folders can also be created by 
message type or by subject.
From Messages application:
1. Open Messages.
2. Select My folders.
3. Press Options and select New folder.
4. Enter a name for your folder and press OK. 

To rename or delete a folder, from Messages application:
1. Open Messages.
2. Select My folders.
3. Scroll to desired folder, press Options and select Rename 

folder or Delete.

Templates
Templates are short sentences in which you fill in the blank, then 
send the message. Template sentences can also be inserted into 
longer messages.
From Messages application:
1. Open Messages.
2. Select My folders. Select Templates.

Note: You cannot create folders within a folder.
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3. Scroll to desired text. Press Options and select Send > Via 
text message, Via multimedia, or Via e-mail.

4. Press  and a new message opens with template text 
already placed. 

5. Fill in needed information and press .

To create your own template text, from Messages application:
1. Open Messages.
2. Select My folders. Select Templates.
3. Press Options and select New template.
4. Enter text, numbers, or symbols, and press Done.

MAILBOX (E-MAIL MESSAGES)
E-mail is received and stored in a separate mailbox. Once you set 
up a mailbox, Mailbox will be renamed and appear with its new 
name in the main Messages list. You can set up to 6 mailboxes; 
each appears separately in the main Messages list.

After your e-mail is set up, use the mailbox to view and send e-
mail. Files such as images, sound and video clips can be attached 
from phone memory or miniSD Card. Supported e-mail clients 
include a standard POP3, IMAP4, SMTP, MIME client. E-mail 
messaging takes place over CSD and GPRS bearerset using 
standard Internet e-mail protocols over TCP/IP.

Configure Mailboxes
From Messages application:
1. Open Messages.
2. Press Options and select Settings.
3. Scroll to E-mail and open.
4. Highlight Mailboxes and open.

Note: In longer messages, at cursor, press Options and select Insert > 
Template. Template text is placed at cursor.

Note: Before you can send or retrieve e-mail, you must first set up a 
mailbox.
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5. Press Options and select New mailbox.
6. Enter information in fields. Fields marked in the phone with a 

red asterisk (*) must have an entry. 
Mailbox name Use default name or enter a name for your 

mailbox and press OK.
* Access point 
in use

Default Access Point supplied by wireless service 
provider

* My e-mail 
address

Enter your own e-mail address and press OK. 
May be supplied by wireless or Internet service 
provider.

* Outgoing mail 
server

Enter SMTP mail server address.

Send message Choose During next conn. or Immediately.
Send copy to 
self

Select Yes or No.

Include 
signature

Select Yes to enter a signature for outgoing 
messages.

User name Enter a name to log into service provider remote 
mailbox.

Password Enter password. 
* Incoming mail 
server

Enter address of incoming mail server (POP or 
IMAP), supplied by service provider.

Mailbox type Select POP3 or IMAP4.
Security Select Off or On. Determined by Internet service 

provider.
APOP secure 
login 
(POP3 only)

Select Yes to use authenticated POP log in; 
encrypts password.

Retrieve 
attachment 
(IMAP4 only)

Select Yes or No to automatically retrieve 
attachment when message is fetched.

Retrieve 
headers 
(IMAP4 only)

Select All to retrieve all message headers, or 
select User defined and type in a number to 
retrieve only the latest headers.
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Select Mailbox Name to Use to Send E-mail
To select which mailbox to use to send e-mail messages, see 
page 67.
If you have more than one mailbox and you start to write a new 
message, the phone notifies you of the mailbox name that is 
currently in use. To change the mailbox, see page 67 to change 
Mailbox in use setting.

Create a New E-mail Message
To create a new e-mail message, see page 53.

Retrieve E-mail
You can view your mailbox either online or offline. When you are 
online, you see your messages stored on the remote server. 
When you are offline, you see messages retrieved from the 
remote server to your phone, or message headers if not yet 
retrieved. IMAP4 protocol allows you to retrieve messages without 
attachments, so large memory files can remain in your online 
mailbox and not be stored in the phone.
You can mark as read or delete messages, or copy them to 
another folder and view message details when offline. Your 
mailbox is synchronised to the server when you go online.
When you receive a new e-mail message, a new message notice 
appears on the standby screen.

To connect to your mailbox, from Messages application:
1. Open Messages.
2. Select Mailbox (or renamed mailbox). 
3. Press Options and select Connect.
4. Once you are connected, press Options and select Retrieve 

e-mail > New, Selected, or All.
• To select certain messages, use Mark/Unmark action.

5. Once messages are retrieved, you can read them offline. 
Press Options and select Disconnect.
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Read Messages Offline
From Messages application:
1. Open Messages.
2. Select Mailbox (or renamed mailbox). 
3. Press No when phone asks to connect to mailbox.
4. Scroll to desired message and open.

Reply to E-mail Messages
From Messages application:
1. Open Messages.
2. Select Mailbox (or renamed mailbox).
3. Highlight desired message.
4. Press Options and select Reply > To sender or To all. 

Copy E-mail Messages
From Messages application:
1. Open Messages.
2. Select Mailbox (or renamed mailbox).
3. Highlight desired message.
4. Press Options and select Copy to folder.
5. Choose from the appropriate folders and press OK.

Sort Message List
From Messages application:
1. Open Messages.
2. Select Mailbox (or renamed mailbox).
3. Press Options and select Sort by > Date, Sender, or 

Subject.

Save Attachment or Data
You can save attachments, such as Contacts cards, Calendar 
items, links to streaming media, and configuration data.
1. Open desired message.
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2. Press Options and select Attachments >      

Add E-mail Address to Contacts Card
From Messages application:
1. Open Messages.
2. Select Mailbox (or renamed mailbox).
3. Open desired message.
4. Press Options and select Add to Contacts > Create new to 

create a new Contacts card using the sender’s e-mail 
address, or Update existing to place the sender’s 
e-mail address in an existing Contacts card.

5. Continue with Create New Contact Cards on page 35 or Edit 
Contact Cards on page 37.

Manage Mailboxes
From Messages application:
1. Open Messages.
2. Press Options and select Settings.
3. Scroll to E-mail and open.
4. Highlight Mailboxes and open.
5. Scroll to desired mailbox name and press Options and select 

Edit or Delete.

DRAFTS
Your unfinished text (SMS), multimedia (MMS), and e-mail 
messages that have not been sent are stored in the Drafts folder.
From Messages application:
1. Open Messages.

Open Open attachment in read-only mode
Save Save attachment
Send Send attachment via Bluetooth® or Infrared 

Note: Attachment cannot be opened, saved, or sent if it has not been 
retrieved.
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2. Scroll to Drafts and open.
3. Scroll to desired message and open.
4. Enter the rest of the information.
5. Press , or if desired press Options and select: 

SENT
Text, multimedia, smart, and e-mail messages that have been 
successfully sent are stored in the Sent folder, which stores the 
last 15 sent messages.

Move Sent Messages to My Folders
From Messages application:
1. Open Messages.
2. Scroll to Sent and open.
3. Scroll to desired message, then press Options and select 

Move to folder.
4. Select desired folder and press OK.

Send Send message
Add recipient Send to more than one address
Insert > Insert items such as Picture, Image, 

Sound clip, Video clip, or Template, 
depending on what type of file the message 
type supports

Attachments (E-mail)
Objects (Multimedia)

Open, insert, or remove attachments or 
objects

Edit presentation  
(Multimedia)

Edit the presentation

Preview message 
(Multimedia)

Preview message before sending

Check contacts Match names in To and Cc fields to names 
in Contacts

Message details View details such as message size
Sending options View or change sending options depending 

on type of message
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View or Delete Sent Messages
To view or delete sent messages and objects or attachments, 
from Messages application:
1. Open Messages.
2. Scroll to Sent and open.
3. Scroll to desired message and open.
4. Press Options and select: 

OUTBOX
Outbox stores messages waiting to be sent, and messages that 
could not be sent; for example, connection to the network failed. 

It also temporarily stores Bluetooth® and Infrared messages that 
are waiting for connection to the receiving device. If the 
connection fails, Outbox does not keep the message.

The Outbox icon  appears on the standby screen when there 
are messages in the Outbox.
Status of Outbox messages:

Send, View, and Manage Outbox Messages
From Messages application:
1. Open Messages.
2. Scroll to Outbox and open.
3. Scroll to desired message. Press Options and select: 

Attachments (E-mail)
Objects (Multimedia)

Open, save, or send attachments or objects

Delete Delete message, object or attachment
Message details View details such as message size

Sending Connecting to network Waiting Waiting to connect

Queued E-mail waiting for 
connection

Resend 
at

If sending failed, resend 
attempt

Deferred Suspend sending to 
another time

Failed Sending has not been 
successful

Defer sending Defer sending until you manually send
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Messages waiting in the Outbox are automatically resent (except 
e-mail set to send during next connection), depending on network 
availability.  
To cancel resending, from Messages application:
1. Open Messages.
2. Scroll to Outbox and open.
3. Scroll to desired message. Press Options and select Delete. 

Message details View details such as message size
Send Send message now
Move to Drafts Move message to Drafts folder, where it can be 

edited and resent
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REPORTS
Delivery reports for text, multimedia, and smart messages can be 
sent by your wireless service provider, and stored in the Reports 
folder. Delivery reports are not available for e-mail messages.
From Messages application:
1. Open Messages.
2. Press Options and select Settings. 
3. For text messages, open Text message, scroll to Receive 

report and select Yes. For multimedia messages, open 
Multimedia message, scroll to Receive report and select 
Yes.

MESSAGE SETTINGS
Text Message Settings
From Messages application:
1. Open Messages.
2. Press Options and select Settings. 
3. Open Text message. Open fields as needed: 
Message 
centres 

Choose from provided list of network and SIM 
message centres 

Msg. centre in 
use

Choose which message centre is used to deliver 
text messages

Receive report Choose Yes or No. If Yes, delivery reports 
showing status of sent text messages are stored 
in Reports folder.

Message 
validity

Choose a time period from 1 hour to maximum in 
which text message delivery is attempted from the 
message centre.

Message sent 
as

Choose Paging or E-mail if you wish to convert 
your text message to one of those forms for 
sending. Available only if network can perform the 
conversion.

Preferred 
connection

Choose GSM or GPRS connection.
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Multimedia Message Settings
From Messages application:
1. Open Messages.
2. Press Options and select Settings. 
3. Open Multimedia message. Open fields as needed: 

E-mail Message Settings
From Messages application:
1. Open Messages.
2. Press Options and select Settings. 

Reply via same 
ctr.

Select Yes to allow your text message recipients 
to use your text message centre to reply to you 
without having to subscribe to a text messaging 
service.

* Access point 
in use

Choose from list of access points. See page 118 
to create and edit access points. 

Multimedia 
reception

Choose Only in home net., Always on or Off for 
incoming messages. 

On receiving 
msg.

Choose Retr. immediately, Defer retrieval or 
Reject message for incoming messages.

Allow anon. 
messages

Select Yes to receive messages from anonymous 
(unknown) senders.

Receive adverts Select Yes to receive advertisements. 
Receive report Select Yes to receive delivery reports.
Deny report 
sending

Select Yes so that your phone will not send a 
delivery report to confirm receipt of a new 
message.

Message 
validity

Choose a time period for the message centre to 
attempt message delivery.

Image size Select Small (default) for 160x120 (max) image 
size, or Large for 640x480 (max).

Default speaker Choose to play sound clips from Loudspeaker or 
Handset speaker.
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3. Open E-mail. Open fields as needed: 

Service Message Settings
From Messages application:
1. Open Messages.
2. Press Options and select Settings. 
3. Open Service message. Open fields as needed: 

Cell Broadcast Message Settings
From Messages application:
1. Open Messages.
2. Press Options and select Settings. 
3. Open Cell broadcast. Open fields as needed: 

Other Message Settings
From Messages application:
1. Open Messages.
2. Press Options and select Settings. 
3. Open Other. Open fields as needed: 

Mailboxes View list of mailboxes you have set up.
Mailbox in use Select mailbox to use to send e-mail.

Service 
messages

Select On to receive service messages.

Download 
messages

Select Manually to allow only authorised senders 
to send service messages.

Reception Select On to receive cell broadcast messages
Language Select All to receive cell broadcasts in all possible 

languages, or Selected to choose from a list, or 
Other if your preferred language is not listed.

Topic detection Select On to view a list of topic indexes provided 
by the network.

Save sent 
messages

Select Yes to save sent messages to the Sent 
folder.
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SIM MESSAGES
To view, copy, or delete text messages stored on the SIM card, 
from Messages application:
1. Open Messages.
2. Press Options and select SIM messages. 
3. A list of messages stored on the SIM card appears. 
4. To view the messages, first copy them to the phone memory. 

Before copying multiple messages, use Mark/Unmark > Mark 
or Mark all to mark any or all desired messages to perform 
copying at one time. Press Options and select Copy.

5. Choose the desired folder to place the copy and press OK.
6. If desired, press Options and select Delete to delete 

messages from the SIM card. 

CELL BROADCAST MESSAGES
Cell broadcast messages are sent by your wireless service 
provider to GSM customers in a certain area. They provide 
general information about topics such as weather reports, traffic 
news, and customer services. Available topic names and 
numbers are supplied by your wireless service provider.

From Messages application:
1. Open Messages.
2. Press Options and select Cell broadcast. 
3. Press Options and select: 

No. of saved 
msgs.

Type in a number to set maximum amount of 
messages saved to Sent folder.

Note: Leaving Cell broadcast set to On reduces battery life.

Open Open topic
Subscribe or 
Unsubscribe

Subscribe to selected topic to receive related 
messages. Select Unsubscribe to stop receiving 
related messages.
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SERVICE COMMAND
Ask your wireless service provider to activate a particular service 
by sending a service command. These commands, which may be 
called USSD commands, can activate services such as mobile 
prepay and chat.
1. Contact your wireless service provider for the proper service 

command statement.
From Messages application:
2. Open Messages.
3. Press Options and select Service command.
4. Enter the service command, then press . 

Hotmark or 
Remove 
hotmark

When topic is hotmarked, you will receive a notice 
when related messages arrive.

Topic > Choose Add manually to type in a topic name or 
topic number or Delete all.

Settings See Cell Broadcast Message Settings on page 68 
to turn on or off Cell broadcast reception, choose 
Cell broadcast language, and turn on or off topic 
detection.
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CAMERA
Take pictures to send in a multimedia or e-mail message, or for 
your Contacts cards. Pictures can also be sent via infrared or 
Bluetooth®.

TAKE A PICTURE
From Camera application:
1. With the flip open, the main display acts 

as a viewfinder. Move the phone around 
to frame your subject.

2. To snap the picture, press .
• The image is automatically saved to 

Images folder. See Gallery on 
page 75.

To send the picture immediately, press . 
Scroll to Via multimedia, Via e-mail, Via Bluetooth, or Via 
infrared. To complete multimedia messages, see page 51; or E-
mail messages on page 53; or Bluetooth® on page 102; or 
Infrared on page 104. 

If you do not want to save it, either:
•  Press  and select Yes
•  Press Options and select Delete.

Change Capture Modes
To choose different picture capture modes, scroll  to select: 
Standard Regular size landscape pictures (640x480 pixels 

[VGA])
Portrait Smaller pictures that use much less memory and 

can be placed in Contacts cards (80x96 pixels)

Note: Camera mode depletes battery power more rapidly. To conserve 
your battery, the phone shifts to camera standby mode after 1 
minute if no keys are pressed.
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• Red number in upper right corner indicates the amount of 
pictures that can fit in phone memory, depending on selected 
image size.

Zoom
You can zoom in on your subject before taking a picture.
1. When viewing your subject in the viewfinder, press  once for 

2x zoom, press  again for 4x zoom. Press  to step back 
one zoom level.

2. Press  to snap the picture.

Self-timer
Set the camera to take a picture after setting the timer to delay the 
shutter.
1. From the viewfinder, press Options and select Self-timer > 

10 seconds, 20 seconds, or 30 seconds.
2. Move the phone around to frame your subject.
3. Press Activate to start the timer.

• The shutter sounds when the picture is taken.
• The image is stored in the Media Gallery Images folder.

Photolight
Light up your subject before snapping a picture. See Photolight on  
page 150.

TAKE A SELF-PORTRAIT
From Camera application:
1. Close the phone flip. The external display acts as a 

viewfinder. Move the phone around to frame your subject.
2. Press Multibutton  on side of phone to snap the picture.
3. Open the flip. The image appears on the main display. 

• The image is automatically saved to Media Gallery Images 
folder. To make changes to the image, press Options and 
select Go to Gallery. See Gallery on page 75.

To send the picture immediately, see Send Pictures on page 74. 
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If you do not want to save it, press Options and select Delete.

SAVE PICTURES
Pictures are automatically saved in the Images folder in Media 
Gallery in phone memory, or you can save them on the miniSD 
Card. 
To save pictures to the miniSD Card, from Camera application:
1. Press Options and select Settings. 
2. Scroll to Memory in use and open.
3. Select NO NAME or the name assigned to your miniSD Card.

• All pictures are saved to the miniSD Card until this setting 
is changed to Phone memory, or miniSD Card is removed.

VIEW PICTURES
From Camera application:
1. Press Options and select Go to Gallery. A list of images 

stored in phone memory displays. Scroll to desired image and 
open.
• Or to view images in miniSD Card, press Back, scroll  to 

miniSD Card tab. Scroll to desired image or folder and 
open.

NAME PICTURES
To change the name that is used as the default file name for new 
images, from Camera application:
1. Press Options and select Settings. 
2. Open Default image name and enter desired text.

• For example, if you change the Image Name to SkiTrip, 
then your pictures will be named SkiTrip, SkiTrip(01), 
SkiTrip(02), etc. until the default name is changed.

To rename an individual image when you have taken a picture:
1. With saved image on main display, press Options and select 

Rename.

Note: To rename your miniSD Card, see miniSD Card (MEMORY 
CARD) on page 143. 
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2. Enter a new name for the image.

PICTURE QUALITY
To choose the compression level (memory size) of future pictures, 
from Camera application:
1. Press Options and select Settings. Open Image quality.
2. Select High, Normal, or Basic. The higher the image quality 

you choose, the larger the file size will be.

If you plan to view pictures on a computer, use High or Normal 
picture quality so the quality will be better maintained when 
enlarged on a computer screen.

Basic picture quality is best when the pictures are viewed on  
phones and other small screens.

SEND PICTURES
Send the picture you just took to your family and friends.
1. With saved image on main display, press , or press 

Options and select Send > Via multimedia, Via e-mail, Via 
Bluetooth, or Via infrared. 

2. To complete multimedia messages, see page 51; or E-mail 
messages on page 53; or Bluetooth® on page 102; or Infrared 
on page 104. 

Add a Picture to Contact Card
To add a picture to a Contact card, see Edit Contact Cards on 
page 37.

Incoming Calls when in Camera Mode
If you receive a call while in camera mode, the phone temporarily 
suspends camera mode and switches to the incoming call display. 
Once you answer the call, the screen returns to Camera mode 
and a small active call icon displays. If a captured image is on the 
preview screen, it is saved in the Media Gallery Images folder. 

Note: All three levels are 640x480 pixels resolution (sharpness). 
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MEDIA
Media menu contains these main options:

GALLERY
Store, play, and manage your pictures, images, video clips, sound 
clips and streaming links (web addresses) in the phone memory 
or miniSD Card. Send media files to friends and family via 
multimedia, e-mail, Bluetooth®, or infrared.
See Specifications in Part 2 of the User Guide for supported 
media file formats.

VIEW IMAGE, SOUND, AND VIDEO FOLDERS
From Media application:
1. Open Gallery.
2. Phone icon tab shows data stored in phone memory, or scroll 

 to view data stored on miniSD Card. 
3. Select folder: 

VIEW IMAGES, ZOOM IN, AND SET AS 
WALLPAPER 
When an individual image is open, you can zoom in/out, rotate 
and view images full screen, and do other actions as listed below.
From Media application:

Gallery PhotoBase RealOne Player

Video Recorder

Documents See File Manager on page 148 to view your 
QuickOffice documents.

Images Scroll to desired image, or open Wallpapers folder 
to view wallpaper files. Contact your network 
operator for availability of Picture msg. service.

Sound clips Choose Digital sounds folder or Tones folder.
Video clips Video clips.
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1. Open Gallery.
2. Phone icon tab shows data stored in phone memory, or scroll 

 to view data stored on miniSD Card. 
3. Open Images folder, then scroll to and open desired image.
4. Press Options and select: 

Zoom, Rotate, and Panning Shortcuts
Zoom  zooms in;  zooms out;  zooms in; press 

again to activate full screen

Pan  and  pan up;  and  pan down;  and 
 pan left;  and  pan right

Rotate  rotates clockwise;  rotates counter clockwise

Original Press and hold  to go back to original size view 

Full screen  switches between full screen view and original 
size view 

• If image is not zoomed, scroll  to go to next image in the 
current folder.

Send > Send file to another device.
Set as wallpaper Set image as wallpaper in standby mode.
Rotate > Rotate image Left or Right in 90 degree steps.
Zoom in / Zoom 
out

Zoom in or out in steps from 12.5% to 800%.

Full screen Removes status bar and softkey text to see more 
of the image.

Normal screen When viewing full screen, press , then select 
Normal screen to view status bar and softkey text.

Rename Rename the image.
View details View details such as file format and size, and 

image creation time and date.
Add to 
favourites

Add a shortcut to view image from Favourites.
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PLAY VIDEO, SOUND CLIPS, AND STREAMING 
MEDIA
Watch video clips and listen to sound clips, or play streaming 
media. Streaming media is sound and video stored and played 
back as it arrives from the Internet or your network servers; thus 
the file is not stored on your phone, taking up valuable memory.
From Media application:
1. Open Gallery.
2. Phone icon tab shows data stored in phone memory, or scroll 

 to view data stored on miniSD Card. 
3. Open desired folder(s), then scroll to and open desired video 

or sound clip. When choosing a link to streaming media, the 
phone begins connection process to the Internet or to your 
network.
• See Player Controls on page 78.

Press Options and select from these additional options: 

Note: For streaming media, after the phone successfully connects to 
the link (web address of streaming media), there is a short 
loading period to prepare playback, then the streaming media 
begins playing. See Player Controls on page 78.

Export to miniSD Copy or move file to miniSD Card.
Copy to Copy file to phone memory or miniSD Card.
Rename Rename clip.
Gallery downloads > Go to download link for images, videos, or 

sounds in Browser.
Recieve via infared Receive a file via infrared.
View details View clip details such as file format, size, res-

olution, and duration.
Add to favourites Add a shortcut to view or listen to clip from 

Favourites.
Settings Adjust multimedia settings (see page 85).

Note: Gallery downloads and Receive via infrared features may not 
be available.
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PLAYER CONTROLS
Video controls 

Sound controls 
To select buttons on screen, scroll  or  to move box to button 
and press : 

Volume control
Scroll  to increase volume; scroll  to decrease volume (note 
bar scale near top of screen).
To mute the sound in a video clip, scroll  until muted speaker 
icon  appears. To turn sound back on, scroll . When playing 
sound clips, the lowest volume setting is level 1. 

SEND PICTURES, VIDEO AND SOUND CLIPS
From Media application:
1. Open Gallery.
2. Phone icon tab shows data stored in phone memory, or scroll 

 to view data stored on miniSD Card. 
3. Open respective folder, then highlight desired file.
4. Press Options and select Send > Via multimedia, Via e-

mail, Via Bluetooth or Via infrared.

Play: Press Options and select Play. Video automatically 
begins playing when first opened.

Stop: Press Stop softkey.
Pause: Press Pause softkey or press . To resume play, 

press   and select Continue, or press Options and 
select Continue.

Fast forward: Press and hold  on navigation key during play.
Fast rewind: Press and hold  on navigation key during play.

Play: Pause: Rewind:

Stop: Fast forward: Record:



   79

5. To complete multimedia messages, see page 51; or E-mail 
messages on page 53; or Bluetooth® on page 102; or Infrared 
on page 104. 

DOWNLOAD PICTURES, VIDEO AND SOUND 
CLIPS
From Media application:
1. Open Gallery.
2. Press Options and select Gallery downloads > Graphic 

downloads, Video downloads, or Tone downloads.
3. The Browser opens. Choose a bookmark site to download the 

desired media.

IMAGE UPLOADER
Store your personal pictures on an image server and share them 
with family and friends. To use this service, (1) you must purchase 
this service from your wireless service provider if it is available, (2) 
you must configure an Internet Access Point.
Contact your wireless service provider to obtain the image server 
settings. Enter the image server settings in the phone (see 
page 79). 

Set Up Image Server
From Media application:
1. Open Gallery.
2. Scroll to an image to highlight it.
3. Press Options and select Image uploader > Settings.

Note: The Send option is not available for streaming media.

Note:  Free content is available for your X700 phone. For downloading 
information, visit www.panasonicbox.com. Availability of this 
service is dependent on your country/ region or network. The 
downloaded content is free, however there will be a 
communication fee to download.

Note: Image Uploader service can support only JPG format files.
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4. Open Image servers. For the first time, select Yes to define 
an image server.

5. Open each field to enter information: 

To edit or add more image servers, press Options and select Edit 
or New image server after opening Image servers. You can also 
delete Image servers here.
To change the image server in use if you have set up more than 
one, open Image server in use setting and select desired image 
server.

Upload Images
To upload images to an image uploader service, from Media 
application:
1. Open Gallery.
2. Scroll to the desired image to upload to highlight it.
3. Press Options and select Image uploader > Upload. 

PHOTOBASE
Take pictures, then show them to your friends in a slide show right 
from your phone. Remove red eye, crop, rotate, or change 
brightness and contrast of your pictures before sharing them. You 
can also add frames, clip art, and text to your pictures. 

Image server 
name

Enter a descriptive name for the image server

* Access point 
in use

Choose desired access point from list. See 
page 118.

User name Enter your user name for the uploader service
Password Enter your password for the uploader service
* Web address Enter the web address of the image server
Auto folder 
naming

Select On to have the current time and date as 
the default name for your folders on the server

Note: For customer support and more information on PhotoBase, visit 
www.arcsoft.com.
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TAKE A PICTURE USING PHOTOBASE
From Media application:
1. Open PhotoBase.
2. Open Camera. 
3. With the flip open, the main display acts as a viewfinder. Move 

the phone around to frame your subject.
4. Press , or press Options and select Snap to take a picture.
The image appears on the display.
To keep the picture in your album, press Keep. 
To delete the picture, press Discard.

Before Taking a Picture
To change the zoom, scroll  or . To change contrast and 
brightness, scroll  or .
Before taking a picture, if desired, press Options and select:

VIEW PHOTOS
From Media application:
1. Open PhotoBase.
2. Open Album. 
3. Scroll to desired photo and open.

• To zoom in or out, press Options and select Zoom In or 
Zoom Out. Scroll , , , or  to pan in zoomed 
images.

• Scroll  to view previous photo; scroll  to view next 
photo.

Mode > Choose Frame to add a frame to the picture. 
Horizontal Panorama and Vertical Panorama 
allow you to stitch 3 pictures together.

Picture folder > Choose the memory to store your pictures. 
Customize allows you to create a new folder.

Settings Configure camera settings.
Go to album Go to your Album.
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Slide Show
To see a slide show of the photos in your Images folder, from 
Media application:
1. Open PhotoBase.
2. Open Album. 
3. Press Options and select Slide show.
4. Select a time interval between slides, and select a transition 

effect, for example, Top to Bottom, to apply as each slide 
advances to the next.

5. Press Play. 
6. Press  to exit.

EDIT PHOTOS
From Media application:
1. Open PhotoBase.
2. Open Album. 
3. Scroll to highlight desired photo and open.
4. Press Options and select Edit.
5. Press Options and select:

Crop Photos
1. With opened photo on screen, press Options and select Edit.

Save Save edited photo in place of original photo
Save as Enter a new name for edited photo and save as a 

new file
Send > Send photo Via E-mail, Via Bluetooth, Via Infra-

red, or Via MMS
(multimedia)

Rotate left Rotate photo to left
Rotate right Rotate photo to right
Brightness&
Contrast

Scroll  or  to adjust brightness, scroll  or  
to adjust contrast

Remove red eye Removes red eye from the photo
Crop See Crop Photos on page 82.
Resize Resize photo by 200% or by 50%



   83

2. Press Options and select Crop.
3. A dotted cropping box appears. Press  to resize the 

cropping box.  Scroll  to make the cropping box taller, scroll 
 to shorten the box. Scroll  to widen the box, scroll  to 

narrow the box size.
4. To move the cropping box within the photo, press Options 

and select Move. Scroll as desired to move the cropping box.
• If you have moved the box, select Resize to adjust the box 

size again.
5. To apply the crop, press Options and select Crop it.
6. To save the cropped photo as a new photo, press Options 

and select Save as. Enter a name for the new photo.

ADD CLIP ART, FRAMES TO PHOTOS
1. With opened photo on screen, scroll  to go to Workshop 

screen.
2. Select Clip Art to add clip art or Frame to add frames.
3. Scroll to desired clip art or frame and select.
4. Once the clip art or frame appears on the photo, press 

Options and select:

5. Press Options and select Send for sending options.

Warp Photos
1. With opened photo on screen, scroll  to go to Workshop 

screen.
2. Select Warp.
3. A black crosshair mark appears on the photo. Scroll , ,  

or  to desired spot where the warp will start. Press  to 
change the mark to red, then scroll in direction you want the 
warp to go.

Move Scroll , ,  or  
Resize Scroll ,  to increase, ,  to decrease
Rotate Scroll ,  to rotate left, ,  to rotate right
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• To add more warp points, press  as needed to toggle the 
mark between black and red.

4. Press Options and select Save, Save as, or Send for desired 
option.

Add Text to Photos
1. With opened photo on screen, scroll  twice to go to Add Text 

tab.
2. Press Options and select Add new line. Enter text as 

desired. To edit text, press Options and select Edit current 
line, Delete current line, Change text color, Change text 
size, and Edit previous/next line. 

3. Press Options and select Save, Save as, or Send for desired 
option.

REALONE PLAYER
RealOne Player is a media player that plays your video clips, 
sound clips and streaming media links (web addresses) stored in 
the phone memory or miniSD Card. Video and sound clips 
attached to messages are automatically played by RealOne 
Player, without having to open the player first. Opening clips from 
Media Gallery, File Manager, Browser, and Favourites 
applications launches the RealOne Player.

See Specifications in Part 2 of the User Guide for supported 
media file formats.

PLAY VIDEO CLIPS AND STREAMING MEDIA
From Media application:
1. Open RealOne.
2. Press Options and select Open > Most recent clips for the 

last several opened media files, or Saved clip to locate 
existing files and links in the phone memory or miniSD Card.

3. Open desired folder(s), then scroll to and open desired video 
or sound clip. When choosing a link to streaming media, the 
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phone begins connection process to the Internet or to your 
network.
• See Player Controls on page 78.

REALONE PLAYER SETTINGS
View and adjust settings for video playback and streaming media 
links.
From Media application:
1. Open RealOne.
2. Press Options and select Settings. 
3. Highlight Video and open.
4. Select from: 

To view and adjust streaming media settings, from Media 
application:
1. Open RealOne.
2. Press Options and select Settings. 
3. Scroll to Connection and open.
4. Select Proxy and select No or Yes.

• If you select Yes, then scroll down and enter the Proxy 
serv. address and the Proxy port number.

5. Press Back and scroll to select Network. Open Network and 
select from: 

Note: For streaming media, after the phone successfully connects to 
the link (web address of streaming media), there is a short 
loading period to prepare playback and then the streaming media 
begins playing. See Player Controls on page 78.

Contrast Open, then scroll  or  to change the percent-
age

Repeat Select On to repeat playback, or select Off to 
playback one time

Default access 
point

Choose one of the access points you have set up. 
See Access Point Settings on page 118.
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Incoming Call when Playing Video
If there is an incoming call during playback of video clips, the 
player pauses the video. It remains paused in the background 
during calls. To resume play, return to opened file and press 
Options and select Continue. 
The player also pauses when an alarm sounds, or a note 
appears, or you open another application. When you return to the 
player, press Options and select Continue. 
If you open an application when streaming video is playing, the 
streaming video pauses, and stops when the auto disconnect time 
period is reached. See RealOne Player Settings on page 85.

Online time Select Unlimited, or select User defined to spec-
ify the amount of time before phone will discon-
nect if there has been no activity

Maximum band-
width

Select a maximum bandwidth for streaming media 
to use

Connection 
time-out

Select a maximum time period to wait from select-
ing a streaming link until it connects to the server. 
Scroll left and right to move the slider and change 
the time period.

Server time-out Select a maximum time period to wait for the 
media server to begin sending the streaming 
media. Scroll left and right to move the slider and 
change the time period

Lowest UDP 
port

Type in a User Datagram Protocol port number

Highest UDP 
port

Type in a User Datagram Protocol port number
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VIDEO RECORDER
Record video clips to send to others, or play clips on your phone.

RECORD A VIDEO CLIP
To record nearby sound with the video, see Video Recorder 
Settings on page 88.
From Media application:
1. Open Video Recorder.
2. The main display acts as a viewfinder. Move the phone 

around to frame your subject.
3. Press Options and select Record to begin recording. Watch 

the screen, then move the phone as needed to keep the 
scene in view.
• Scroll  to zoom in; scroll  to zoom out if zoomed in.
• Press Pause to pause recording; press Resume to resume 

recording.
4. The video recorder records until reaching the clip size limit 

(specified in File Duration in Settings), or until you press Stop 
softkey.  

5. Wait for a few seconds while the video clip is saved to Media 
Gallery Videos folder, or the miniSD Card according to Video 
storage setting. The last still image of the recording remains 
on screen.

To send the video clip immediately, see Send a Video Clip on 
page 88. 

Note: Video Recorder mode depletes battery power more rapidly. To 
conserve your battery, the phone shifts to standby mode after 40 
seconds if recording has not started. Press Options and select 
Continue to return to viewfinder mode. 
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If you do not want to save it, press  and select Yes, or press 
Options and select Delete.

SEND A VIDEO CLIP
1. With the video clip on screen, press , or press Options 

and select Send > Via multimedia, Via e-mail, Via 
Bluetooth, or Via infrared.

2. To complete Multimedia messages, see page 51; or E-mail 
messages on page 53; or Bluetooth® on page 102; or Infrared 
on page 104. 

Play a Video Clip
To play the video clip that was just recorded, press Options and 
select Play.
To play a stored video clip, from Media application:
1. Open Video Recorder.
2. Press Options and select Video Album.
3. Continue with step 3 in  Play Video, Sound Clips, and 

Streaming Media on page 77.

VIDEO RECORDER SETTINGS
From Media application:
1. Open Video Recorder.
2. Press Options and select Settings.
3. Select from: 

Note: The quality of display images may vary depending on the object 
or environment.
Display images may distort when shooting moving objects, 
especially in a fast moving environment. 

Resolution Choose the size of the display on the screen to be 
Low or High.

Audio
recording

Set to On to capture nearby sound as you record. 
Off turns off the microphone.
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PhotoLight
Light up your subject before recording a video clip. See Photolight 
on page 150. 

Incoming Calls when in Video Recorder Mode
If you receive a call while in video recorder mode, video recording 
stops and the video clip is saved. After the call ends, the last 
image of the recorded clip displays. 

Video name 
base

Enter desired text. For example, if you change the 
name to SkiTrip, then your video clips will be 
named SkiTrip; SkiTrip(01); SkiTrip(02), etc. until 
the default name is changed. 

Video storage Choose whether video clips are stored in phone 
memory or on miniSD Card.

File Duration Choose a fixed size for recorded clips, or unlim-
ited size.

Video quality Choose Low or High.
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CONNECTIVITY
Browse the Internet. View and manage your phone’s connections 
to other devices that can be connected to the phone, wirelessly 
and by cables. Synchronise your Contacts and Calendar entries 
with your other networked devices. Your network, Internet, and e-
mail service providers can help you configure and manage your 
connection settings using Device Manager. View your active 
connections using Connection Manager.

Connectivity menu contains these main options:

BROWSER
Your phone has an XHTML configured wireless Internet browser, 
allowing you access to services such as news, weather reports, 
banking, sports, travel information and stock quotes.

Wireless web sites are designed to be viewed on mobile phone 
screens, so they consist mostly of text and may contain simple 
graphics. Wireless sites are written in Wireless Markup Language 
(WML) and XHTML (Extensible Hypertext Markup Language), 
which is different from Hypertext Markup Language (HTML) used 
in computer Internet websites and cannot be accessed by 
wireless phones.

Your phone browser can access WAP 2.0 sites and download 
games, sound, software, WBMP images, vCard and vCalendar 
events, and more.

Types of Data Connections
GPRS and data call (CSD) data bearer technologies are used to 
access the Internet.

Browser Operator Modem

Bluetooth Infrared USB

Conn Mgr SyncML Dev Mgr
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GPRS is General Packet Radio Service, a packet based high 
speed data transfer technology that allows continuous 
connection, in which many users share a connection and packets 
are transferred only as needed.

Data call, or CSD, is Circuit Switched Data, which uses a 
dedicated connection much like ordinary voice phone service. 

SETUP TO CONNECT TO BROWSER
Before starting: (1) you need a subscription for data services from 
your wireless service provider, and (2) you must configure an 
Internet Access Point. 
Your wireless service provider may have already completed the 
Internet Access Point connection settings, or sent them to you in a 
message. Contact your wireless service provider to find out how 
setup information is furnished.
If you are setting up the Internet Access Point, see page 118.

CONNECT TO THE INTERNET
There are two main ways to store shortcuts to wireless Internet 
sites. (1) Bookmark list  stores web addresses that you or 
your wireless service provider saved to the list. (2) Saved Pages 
list  stores actual WAP pages that you can view online or 
offline.

From Connectivity application:
1. Open Browser.
2. A list of Internet Access Points and bookmarks appears, and 

folders may appear. Your wireless service provider may have 
loaded links to their services that appear as bookmarks. Scroll 
to the desired connection or bookmark and select.

Note: The types of services and content offered when connected to the 
Browser are supplied entirely by your wireless service provider.

Shortcut: Press  to launch Browser.
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• You can also scroll  for the Saved pages list , which 
stores WAP pages that you can view offline, and launch to 
refresh pages.

3. The phone begins connection process.

NAVIGATE THE INTERNET
In general, when connected to the Internet through the Browser:  

Secure Connections
A secure connection means that the connection to transmit data 
between the phone and the network server has been secured and 
encrypted. Your wireless service provider is responsible for 
securing the connection between the network server and Internet 
sites.

Ask your wireless service provider for details of their secure 
connection capabilities. Proceed with caution when downloading 
files and content or entering sensitive information.

Note: Your wireless service provider may have set your phone to go to 
the Home page for their services when you launch Browser.

Scroll up , down , left  or right  by pressing outer edges of 
navigation key through the page content.
Select a highlighted item or launch an underlined web page.
Press and hold to open Bookmarks list.
Erase character.

Back - Go backward in navigation history.
Close - Go to Bookmarks or Saved pages view.
Cancel - Ends current download.
Press and hold to disconnect the Browser at any time.

Indicates secure online browsing connection.

Note: If you go to a site with many graphics, it may take longer for the 
images to load. To stop images from loading, see Show images 
setting on page 95.
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Online Options
During an Internet connection, you can add and refresh 
bookmarks, reload pages, and view active session details.
Press Options and select:
Open Open highlighted link.
Accept Accept your text entry to the current page.
Service 
Options >

Open a list of commands or actions for the page.

Bookmarks View Bookmarks list.
Save as book-
mark

Save the web address to your Bookmarks.

View image If there are images on the page, open a list of 
images. To view a specific image, scroll to the 
image and press OK.

Navigation 
options >

Go to web address, History to select a previ-
ously viewed page during current session, Clear 
cache to delete content in cache memory, Reload 
to update current page.

Advanced 
options >

Original screen to fit page into the display of your 
phone, Save page to save current page to Saved 
pages list, Disconnect to end connection.

Show images Appears if you have set the Show images setting 
to No in the Browser settings to allow the images 
on current page to load.

Send 
bookmark >

Send current page via text message.

Find > Find phone number, e-mail address or web 
address on current page. Start typing for Find field 
to appear. 

Details View details and security of current session.
Settings See Browser Settings on page 95.
Service msg. Appears if you have unread WAP push mes-

sages.
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When online, you may have calling options from a current page. 
You can click on a link to book tickets or order gifts, for example. 
The link allows you to make a phone call directly from the 
browser. 

When viewing any Directory services an 'Add to Contacts' link 
may appear. Click on the link, and a new Contacts entry form 
displays. Save the entry to return to the browser.

Disconnect from Internet
To disconnect from the Internet, either press and hold , or 
press Options and select Disconnect.

BOOKMARK OPTIONS
Manage your bookmarks when offline or online.
From Connectivity application:
1. Open Browser.
2. Press Options and select:
Download Connect to selected bookmark.
Bookmark man-
ager >

Move to folder, New folder, Edit bookmark, 
Add bookmark, Delete.

Mark/Unmark > Select Mark or Mark all to perform actions to 
multiple items.

Navigation 
options >

Go to web address or Clear cache.

Advanced 
options >

Add to Favourites to add the bookmark to your 
Favourites shortcuts.

Send > Send web address to another device.
Find bookmark Type in one or two characters to go to bookmark 

titles beginning with that character.
Settings See Browser Settings on page 95.
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DOWNLOAD FILES FROM THE INTERNET
You can download ringtones, games, video and sound clips, and 
applications to your phone through the Browser. After 
downloading, the files are saved to the relevant menu application 
in the phone.

From Connectivity application:
1. Open Browser.
2. Scroll to Download Applications, Download Images, 

Download Skins, Download Sounds, or Download Videos, 
and open.

3. Scroll to desired bookmark if there is more than one, then 
open the bookmark. The phone begins connection process.

4. After connecting to the site, scroll to desired hotlink containing 
the file and open.

5. After the file is downloaded, it is stored in the menu 
application in which the file is opened; for example, a video 
clip is stored in Gallery.

BROWSER SETTINGS
Check your default access point, specify if you want images to be 
automatically loaded, and allow cookies to be stored on the 
phone.
From Connectivity application:
1. Open Browser.
2. Press Options and select Settings to reach: 

Note: This feature may not be available.

Note: Panasonic is not responsible for the performance of downloaded 
content or possible corruption of phone software.

          The phone may not allow you to copy, modify, transfer or forward 
some copyrighted images, ringtones or other content.

Default access 
point

Change default access point for connecting to the 
Internet through the Browser.
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SAVED PAGES
Saved pages are web pages and folders you have stored on the 
phone to view offline. 
From Connectivity application:
1. Open Browser.
2. Scroll  to open the Saved pages tab .
3. Scroll to the desired page and select.
4. Press Options and select:

Show images For faster Internet surfing, select No to stop 
images from automatically loading. When online, 
press Options and select Show images on a 
specific page to load an image.

Font size Select a font size for web page text to appear.
Default 
encoding

For the Browser pages to display text characters 
correctly, select one from: S. Chin., West. Europ., 
T. Chinese, Unicode (UTF-8), Central Eur., Baltic, 
Cyrillic, Greek, Turkish, Heb. (ISO-Logical), Hebr. 
(ISO-Visual), Arabic (ISO), Arabic (Windows), 
Hebr. (Windows), Cent. Eur. (Wind.), Cyrillic (Win-
dows), Greek (Windows), Turkish (Wind.), Baltic 
(Windows) or Automatic.

Cookies Choose Allow to store cookies, which are short 
text files that a web server places on your phone 
for purposes such as presenting customised web 
pages to you.

Security warn-
ings

Choose Show or Hide for secure site notification.

Conf. DTMF 
sending

Select First time only or Always before sending 
DTMF touch tones during a call when online.

Open View saved page or open folder.
Back to page Return to page you visited before opening Saved 

pages.
Reload Download and store the latest version of the saved 

page.
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OPERATOR MENU
Your network operator may offer services that you can view using 
the Browser. Contact your network operator for availability and 
types of services offered.
From Connectivity application:
1. Open Operator.
2. In the page, press Options and select:

Saved pages 
mngr. >

Move to folder to move a saved page to a different 
folder, New folder, Rename or Delete.

Mark/Unmark > Select Mark or Mark all to perform actions to multi-
ple items.

Navigation 
options >

Clear cache to delete content in cache memory.

Advanced 
options >

Add to Favourites to create shortcut to page from 
Favourites application.

Settings See Browser Settings on page 95.

Open Open highlighted link.
Close 
browser

Disconnect from your operator's service pages.

Navigation 
options >

Go to web address to go to new address, History to 
select a previously viewed page during current session, 
Reload to update current page.

Advanced 
options >

Original screen to fit page into the display of your 
phone, Save page to save current page to Saved 
pages list, Disconnect to end connection.

Find > Find phone number, e-mail address or web address on 
current page. Start typing for Find field to appear.

Details View details and security of current session.
Settings See Browser Settings on page 95.
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MODEM
You can link together your X700 phone as a modem to a 
computer or a PDA to access the Internet. 

Link your phone and computer to access the Internet
To use the X700 phone as a modem there are three options; 
connect using the infrared port, connect using Bluetooth®, or 
connect using the Panasonic USB Data Cable (EB-UCX71). See 
Accessories on page 166 for USB Data Cable information.

Prerequisites
• Set up a dial-up account with an Internet Service Provider 

(ISP).
• From your ISP, you need the installation CD or your account 

details (i.e. dial-up number, user name, password, DNS server 
addresses) to configure Dial Up Networking.

• When setting up your Internet account for the first time, select 
X700 as the connecting modem device. For more details, 
contact your ISP.  For help using Windows® Dial Up 
Networking, search Windows® Help files.

Install X700 as Modem on Computer
The following describes how to set up a computer to connect to 
your X700. The procedure described may differ for other software 
packages.

To install your phone as a modem on a computer, here is an 
example. On the computer, select Start > Settings > Control Panel 
> Modems > Add > Other > Don't detect my modem > Standard 
33600 bps modem > Communications Port > Virtual Com Port. 
For specific instructions on your computer's operating system, 
refer to your computer's on-line help.

Note: This info may be on CD-ROM.

Note: If connecting with a data cable, select Com 1 in the 
Communications Port field.
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Set Up Connection
From Connectivity application:

1. Open Modem. 
2. Align the infrared port of your phone with the infrared port of 

the computer.
3. Select Connect via infrared, which opens the infrared 

connection.
• To use Bluetooth®, you must start the Bluetooth® 

connection from the computer or device to which you are 
connecting. To prepare your phone to connect via 
Bluetooth®, see Set up Bluetooth on page 100. 

• To use USB data cable, you must start the connection from 
the computer or device to which you are connecting.

4. The phone confirms when a connection is established.
• If Bluetooth® connection is successful, when you select 

Connect via infrared, the phone will state that the modem is 
already in use by Bluetooth®.

Make Connection to Internet

1. Now you can create a new GPRS connection. For example, 
on the computer, select Start > Programs > Accessories > 
Communications > Dial-Up Networking > Make New 
Connection. For specific instructions, see your computer's on-
line help.

2. Enter X700 as the name you are dialling, and choose 
Standard 33600 bps Modem as the device then select Next. 
Choose 115200 as the Maximum speed. In the telephone 
number field,  enter *99# then click Finish.

3. You will now have an X700 connection icon in the computer's 
connection screen. Double click the icon and select Connect 
to begin the connection. 

Note: To close the connection, press Disconn. softkey. If there is an on-
going data call, the call is ended first.
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BLUETOOTH® WIRELESS TECHNOLOGY
Bluetooth® wireless technology uses radio waves to communicate 
with other Bluetooth® devices within a maximum range of 10 
metres. You can send and receive business cards, pictures, 
Calendar events, video and sound clips, and other data between 
Bluetooth® devices such as mobile phones and computers. 

Use a Bluetooth® headset to talk wirelessly on your phone whilst 
the phone is in your pocket or purse. 

This phone supports Bluetooth® v1.1 connectivity with the 
following profiles:  Serial port, Dial-up networking, Object push, 
File transfer, Headset, and Handsfree..  

SET UP BLUETOOTH®

You must first set up Bluetooth® connections 
before using it for the first time. Thereafter, go 
to the Settings tab to switch Bluetooth® setting 
on or off and change your phone’s visibility to 
other Bluetooth® devices.
From Connectivity application:
1. Open Bluetooth.
2. In the Settings tab, open fields:   

Note: Although Bluetooth® devices can connect within a 10 metre 
range, walls or other nearby barriers may cause interference.
Check with local authorities before using Bluetooth® wireless 
technology as some countries may restrict the use of Bluetooth® 
devices.

Battery note: Keeping Bluetooth® setting “On” consumes battery power 
more rapidly. To conserve battery power, switch off 
Bluetooth® setting when not in use. Switch Bluetooth® on 
or off in Settings.

Bluetooth Select On or Off.
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PAIR WITH OTHER DEVICE AND CONNECT
From Connectivity application:
1. Open Bluetooth.
2. Scroll  to Paired devices tab.
3. Ensure that the device in which you want to pair is switched 

on, and its Bluetooth® setting is activated.
4. Press Options and select New paired device. If Bluetooth® 

setting is switched off, press Yes to switch on Bluetooth® 
setting. 

5. The phone begins searching for devices and notifies you 
when it finds the other device.

6. Press Select. Enter the passcode for the connecting device if 
needed and press OK. If the other device has not yet been 
paired, first decide on a passcode with the other person, then 
enter it when requested, press OK.

7. To connect with the device, open the device name and select 
Connect.

My phone’s 
visibility

Choose Shown to all to allow other Bluetooth® 
devices to find your phone when searching, or 
select Hidden to keep other Bluetooth® devices 
from finding it during a search.

Visibility Time-
out

Choose Disabled to keep My phone’s visibility 
setting as Shown to all, or scroll to select a time 
period after which your phone cannot be found by 
other Bluetooth® devices (My phone’s visibility 
setting changes to Hidden).

My phone’s 
name

Use the default name or enter a name for your 
phone that other devices will see when they 
search for your phone.

My Transfer 
Speed

Choose Normal, Fast, or Very Fast.

Note: The passcode may be stated in the connecting device user guide.
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SEND AND RECEIVE DATA VIA BLUETOOTH®

You can send and receive Contacts cards as business cards, 
Calendar events, pictures, video and sound clips, bookmarks, and 
configuration messages, and receive applications supported by 
the phone via Bluetooth®.

To send data via Bluetooth®:
1. Ensure that the device in which you want to pair is switched 

on, and its Bluetooth® setting is activated. On your phone, go 
to the application menu that contains the data you wish to 
send, for example, go to Contacts to send a business card.

2. Highlight the desired item to send.
3. Press Options and select Send > Via Bluetooth. If 

Bluetooth® setting is switched off, press Yes to switch it on. 
4. The phone automatically searches for Bluetooth® devices 

nearby.
• Devices appear one-by-one. If device has already been 

paired,  icon appears with device name. Press Stop to 
stop search when intended device name pops up.

• If the other device has not yet been paired, first decide on a 
passcode with the other user, then enter it when requested, 
press OK. 

5. Scroll to the intended device and select. Connecting message 
appears, then when other device accepts, a confirmation 
message displays when transfer is complete.
• If the other device does not accept the data, Bluetooth® 

connection cannot send the data. 

To receive data via Bluetooth®:
1. Press Show to accept the incoming message containing the 

data. (If phone is not in standby mode, Show does not 
appear.) The message is placed in the Inbox in Messages.

Note: The phone may not allow you to copy, modify, transfer or forward 
some copyrighted images, ringtones or other content.



   103

2. Open the message, press Options and select Save to save 
data to phone memory or miniSD Card. You can rename the 
file.

MANAGE PAIRED DEVICES
From Connectivity application:
1. Open Bluetooth.
2. Scroll  to Paired devices tab and scroll to desired device.
3. Press Options and select: 

Icons of paired devices   

INFRARED
Transfer data between your phone and other infrared enabled 
devices using an infrared wavelength connection. You can also 
use infrared connections for GSM data services, and access the 
Internet and e-mail via other devices.  

Note: Confirmation is required first if the paired device is not set as 
authorised.

New paired device Search for nearby Bluetooth® devices.
Assign short 
name

Change name of paired device to an easily rec-
ognised name.

Set as authorised 
or Set as 
unauthorised

Allow automatic connection without manually 
accepting each time, shown by  icon. Unau-
thorised setting requires confirmation each time 
the device attempts to connect to the phone.

Delete Delete the paired device from your list.
Delete all Delete all paired devices.

audio computer phone miscellaneous

Note: Multiple devices can be paired; however, only one active 
connection is possible at any given time.

Note: The phone may not allow you to copy, modify, transfer or forward 
some copyrighted images, ringtones or other content.
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PREPARE FOR INFRARED CONNECTION
Place your phone and the other device within the effective range 
of the infrared connection, about 20 cm.
• Verify there are no obstructions between the two devices.
• Ensure that the infrared ports of the devices point at each 

other.
• On the receiving device, activate the Infrared port.
• If the other device is a computer, you need to set up infrared 

connection on the computer. For example, in Windows®, select 
Start > Settings > Control Panel > Options tab > Enable 
Infrared Communication. For specific infrared set up 
instructions for your computer’s operating system, refer to the 
computer’s on-line help.

SEND AND RECEIVE DATA VIA INFRARED
You can send and receive Contacts cards as business cards, 
Calendar events, pictures, sound clips, bookmarks, and 
configuration messages via infrared, and receive applications 
supported by the phone.
To send data via Infrared:
1. Prepare for infrared connection as described on page 104.
2. Go to the application menu that contains the data you wish to 

send, for example, go to Contacts to send a business card.
3. Open the item you wish to send.
4. Press Options and select Send > Via infrared.

Caution: This device contains a low power level Class 1 laser product 
(Infrared LED), which will not normally harm the eyes. Though 
invisible to the eye, do not point the infrared beam at anyone’s 
eye. Nearby activated infrared devices may cause 
interference.

Note: For Windows® 2000 users, to enable infrared use to transfer files, 
go to Start > Settings > Control Panel > Wireless Link. In the File 
Transfer tab, check “Allow others to send files to your computer 
using infrared communications”. 
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5. The phone automatically begins infrared connection, indicated 
by flashing . Whilst transferring, icon is steady. A 
confirmation message displays when complete.

To receive data via Infrared:
1. Prepare for infrared connection as described on page 104.
2. From Connectivity application, open Infrared.
3. Flashing icon  displays, meaning phone is ready to receive 

data. 
4. Sender can begin transfer of data. A tone sounds when 

transfer is complete.
5. Press Show to accept the incoming message containing the 

data. The message is placed in the Inbox.
6. Open the message, press Options and select Save to save 

data to supporting application. You can rename the file.
• If transfer does not begin within 40 seconds, the infrared 

connection automatically stops.

USB
Connect to PC Software Suite over your USB cable using USB 
application.

CONNECT TO PC SOFTWARE SUITE
1. Plug USB cable into the phone.
2. From the Connectivity application, open USB.
3. USB icon appears indicating that USB connectivity has 

started.
4. On your computer, begin desired task such as backup or 

sync.

CONNECT TO MODEM
1. Plug in USB cable into the phone.
2. From the Connectivity application, open Modem.
3. Select Connect via USB.
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4. USB icon appears indicating that USB connectivity has 
started.

5. On your computer, start a connection using the phone as a 
modem.

CONNECTION MANAGER
View status, speed, and amount of data transferred for all of your 
currently active GPRS and Data call network connections.

VIEW CONNECTION DETAILS
From Connectivity application:
1. Open Conn Mgr..
2. A list of currently active network connections appears, sorted 

according to starting time of connection.
3. Scroll to desired connection, press Options and select 

Details to view name, bearer (GPRS, data call), status 
(creating connection, idle, active, on hold, closing connection, 
or closed), received and sent data amount in bytes, duration, 
downlink and uplink transfer speed in kb/sec, dial-up number 
(data call only), GPRS access point name (GPRS only), and 
sharing.

END CONNECTIONS
From Connectivity application:
1. Open Conn Mgr..
2. A list of currently active network connections appears, sorted 

according to starting time of connection.
3. To end one connection, scroll to desired connection, press 

Options and select Disconnect.
To end all active connections, press Options and select 
Disconnect all.
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• If you are ending all connections, the Data call connections 
are closed first, then the GPRS connections close in the 
same order as established.

SYNCHRONISATION
Set up profiles and synchronise your Contacts and Agenda 
(Calendar) entries with your other networked devices.

CREATE A NEW SYNC PROFILE
From Connectivity application:
1. Open SyncML.
2. If there are no profiles, select Yes to create a new profile. Or, 

press Options and select New sync profile, then press Yes.
3. Enter information in fields. Fields marked in the phone with a 

red asterisk (*) must have an entry. 

4. Next, scroll  to move to Content tab.
5. For each field, press Options and select Change, then select 

Yes.
6. Open Remote database and enter location on the network of 

each of the databases.
7. Open Synchronisation type and choose whether you want 

to synchronise in both directions (Normal), from server to 
phone (To server only), or from phone to server (To phone 
only) for each database.

Note: GPRS connection cannot be closed if it is currently suspended 
due to circuit-switched activity.

* Sync profile 
name

Enter a name if not assigned.

Access point Select desired access point name.
* Host address Enter web address of sync server.
Port Enter port number of sync server.
User name Type your user name for the server.
Password Type in password.
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SYNCHRONISE
If you are synchronising from the server to the phone, you will 
receive a message in the Messages Inbox. When you open the 
message, you are asked if you wish the server to begin the 
synchronisation process. If you accept, the process automatically 
begins.
To begin synchronising from the phone, from Connectivity 
application:
1. Open SyncML.
2. Highlight desired profile, press Options and select 

Synchronise.

During synchronisation from either direction, you can follow the 
process on the phone. The phone confirms completion.

To cancel synchronisation, press Cancel.
If synchronisation fails, for example, the sync server is busy or the 
database cannot be opened, you are notified of the error type.

VIEW OR EDIT SYNC PROFILES AND 
CONTENT
From Connectivity application:
1. Open SyncML.
2. Highlight desired profile, press Options and select Edit sync 

profile.
3. Scroll to desired fields to view and open to edit.

If a profile has been synchronised, press Options and select 
View log to view profile name, remote server name, date, time, 
and status of last synchronisation, and details of content transfer.

To view or edit the Content settings, scroll  to view the Content 
tab and continue with step 6 in Create a New Sync Profile on 
page 107.
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DEVICE MANAGER
Your network, Internet, and e-mail service providers can help you 
configure and manage your connection settings. These settings 
can be sent to your phone over the air. Device Manager menu 
allows service providers to configure and update these settings 
from their servers on your behalf. Settings may include network 
access points, multimedia, e-mail, and synchronisation 
connections.

CONFIGURATION SESSION
A configuration session can be started either from the Device 
Manager application in the phone, or from the service provider’s 
server.

If your service provider intends to start a session, your phone will 
show a server alert message. Before the session can begin, your 
phone asks you to activate the server connection and the profile if 
they are off. Then the phone asks you to accept that the server is 
ready to configure. If you don’t want the session to run, press 
Reject or Cancel.

Once the configuration session begins, the phone displays status 
notes advising the session stage: connecting to the server, 
receiving data from the server, processing data, and 
disconnection.
To start a configuration session yourself (if server profile is set 
up), from Connectivity application:
1. Open Dev Mgr..
2. Scroll to desired server profile in which you wish to start 

configuration session.
3. Press Options and select Start.

Note: If you set the server profile to accept configuration sessions 
without verification, then the session will begin in the background. 
View the process by opening Device Manager application.
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CREATE A NEW SERVER PROFILE
The server profile is the settings needed to connect your phone to 
a service provider’s device management server, which handles 
the configuration session procedure.
From Connectivity application:
1. Open Dev Mgr..
2. If there are no profiles, select Yes to create a new profile. Or, 

press Options and select New server profile.
3. Enter information in fields. Fields marked in the phone with a 

red asterisk (*) must have an entry. 

VIEW OR EDIT SERVER PROFILES
From Connectivity application:
1. Open Dev Mgr..
2. Scroll to desired server profile, press Options and select Edit 

profile, or Delete.

* Server name Use suggested name or enter your own. 
* Server ID Server’s unique ID identifies the remote server.
Server 
password

Server password supplied by service provider so 
your phone can verify server.

Access point Select desired access point.
* Host address Server’s web address.
Port Server’s port number.
* User name Type in your user name for the server.
Password Device Manager password supplied by service 

provider so the server can verify your phone.
Allow configu-
ration

Select Yes to allow device management to be 
done by this server.

Accepted Select Yes to allow device management to be 
done by this server without Accept command.
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View Session Log
To view the results of a selected server’s last configuration 
session, from Connectivity application:
1. Open Dev Mgr.
2. Scroll to desired profile, press Options and select View log.

The log shows name of server configured, results of configuration, 
date and time, and errors if any occurred during configuration.

SHORTCUT TO STOP CONFIGURATION 
SESSIONS
There may be times in which you do not want configuration 
sessions to run. Instead of going to each server profile to set 
Active to not allow device management to be done by the server, 
you can set the phone so that device management cannot be 
done by any server.

The default setting is to allow device management to be done 
(Enable configurations).

From Connectivity application:
1. Open Dev Mgr..
2. Press Options and select Disable config..

• All server profiles are disabled and no configurations can 
be done.

To allow configurations to be done again, press Options and 
select Enable config..

 



112      

SETTINGS
Choose your ringtone and theme settings here. Configure your 
phone, call, connection, security, call divert, barring, GSM 
network, and accessory settings. Set the clock, alarms, and 
speed dial shortcuts.

Settings menu contains these main options:

RINGTONES
Ringtone profiles are unique ringing tone, alert tones, and volume 
settings used to alert you to calls and messages. Choose from 
General, Silent, Meeting, Outdoor, and Pager. Each can be 
modified to suit your situation. You can use ringtones sent in a 
message, sent by Bluetooth® or infrared connections, recorded 
with the Recorder application, or downloaded. 

The active ringtone name is displayed in the standby screen, 
except when General is active.

ACTIVATE A RINGTONE
From Settings application:
1. Open Ringtones.
2. Scroll to the desired ringtone.
3. Press Options and select Activate. 

Ringtones Themes Settings

Clock Speed Dial Voice

PB Setup About

Note: Free content is available for your X700 phone. For downloading 
information, visit www.panasonicbox.com. Availability of this 
service is dependent on your country/region or network. The 
downloaded content is free, however there will be a 
communication fee to download.
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CHANGE RINGTONES, ALERT TONES AND 
VOLUME
You can change, or personalise, individual settings within a 
ringtone. For example, in General ringtone, change the ringing 
tone to a ringing tone you downloaded.

From Settings application:
1. Open Ringtones.
2. Scroll to the desired ringtone.
3. Press Options and select Personalise. 
4. Scroll to the desired setting:    
Ringing tone, 
line 1

Scroll through list of tones. To hear the tone, high-
light the tone name and wait. To stop the tone, 
press any key. To select a tone, highlight the tone 
name and press Select.

Ringing tone, 
line 2

Same as Line 1 ringing tone.

Ringing type Choose Ringing, Ascending, Ring once, Beep 
once, or Silent.

Ringing volume Scroll  to move the volume bars.
Message alert 
tone

Same as Line 1 ringing tone.

Chat alert tone Same as Line 1 ringing tone.
Vibrating alert Select On or Off.
Keypad tones Select Off, Level 1, Level 2, or Level 3.
Warning tones Select On or Off.
Alert for If you have set up Contacts groups, select the 

desired group name if you want the phone to ring 
only when members of that group call. Other 
incoming calls will have the silent alert.

Profile name Change the name of any ringtone except General.
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Ringing and Alert Tone Volume
Ringing and alert tones play only when the phone’s current 
ringtone is General or Outdoor. The other ringtones mute playing 
of ringing tones.
To change the volume of tones when scrolling through the list, go 
to the Ringing volume field and adjust volume. 

THEMES
Change the visual look of your phone screens without changing 
the way the phone works by using Themes. Themes are 
wallpapers, text and icon colours and sets packaged in a theme. 
Themes, or skins, are preinstalled when you purchase your 
phone, or you can download and install them yourself. 

PREVIEW THEMES
From Settings application:
1. Open Themes.
2. Scroll to the desired theme name.
3. Press Options and select Preview.

ACTIVATE A THEME
From Settings application:
1. Open Themes.
2. Scroll to the desired theme name.
3. Press Options and select Apply.

• When previewing, press Apply to activate the theme.

Note: Free content is available for your X700 phone. For downloading 
information, visit www.panasonicbox.com. Availability of this 
service is dependent on your country/region or network. The 
downloaded content is free, however there will be a 
communication fee to download.

Note: The appearance of some icons may change when you apply a 
different theme.
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CHANGE WALLPAPER OR SCREENSAVER
Change the background image of the standby screen or 
Favourites screen, the colour of bars and frame boxes, and the 
screensaver.
From Settings application:
1. Open Themes.
2. Press Options and select Edit; or to edit a specific theme, 

first scroll to desired theme before pressing Options:    

DOWNLOAD NEW THEMES
You can download themes directly from predetermined web sites 
without first going to the Browser application. These links are set 
by agreements with content providers who offer the themes. 
From Settings application:
1. Open Themes.
2. Press Options and select Theme downloads.
3. A folder displays, containing links to content provider web 

pages.
• You can add your own links to the folder.

4. Open the folder and scroll to and open desired link.

Idle state wallpaper Idle screen. Choose from Default, User 
defined (your own image from Gallery or 
downloaded), other themes, or None.

Colour palette Choose from the default colour or other 
listed colours for common bars, icons, and 
frames.

Screen saver Choose Date and time(Default), or Text 
(write your own text message).

Icons Choose from a list of theme set of icons.
Favourites wallpaper Favourites. Choose from Default, User 

defined (your own image from Gallery or 
downloaded), other themes, or None.

Note: When the copy option appears, you can copy themes from the 
phone memory to the miniSD Card or in reverse.
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5. Connection to the Browser will begin.

SETTINGS
In the Settings menu, you can configure your phone, call, 
connection, date and time, security, call divert, barring, GSM 
network, and accessory settings.

PHONE SETTINGS
Set the phone language, writing language, 
and welcome note or logo here.  
From Settings application:
1. Open Settings.
2. Open Phone.

3. With General highlighted, open to select: 

Note: Some links may be preset by content providers and cannot be 
deleted.

Phone 
language

Choose a language in which the texts on the displays 
will appear. Automatic uses the language dictated by 
the SIM card.

Writing 
language

Choose a language in which the texts you are writing 
will appear, for example, writing a text message.

Dictionary Select On to use the predictive text dictionary to 
speed up text entry.

Welcome 
note or logo

Default uses the welcome note or image supplied 
with the phone, displayed when the phone is 
switched on. Select Text to enter your own welcome 
note. Select Image to place an image from Media 
Gallery.

Orig. phone 
settings

Used if a network operator used settings protection in 
a phone, and later there is a reason to change the 
protected settings. Requires lock code.
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Display Settings
Adjust the brightness of the display screen and set a screen saver 
timeout.
From Settings application:
1. Open Settings.
2. Open Phone.
3. Scroll to Display and open. Select and open:

Standby Mode Settings
Choose an application name to display on the left and on the right 
softkey in standby mode to use as shortcuts to the respective 
applications.
From Settings application:
1. Open Settings.
2. Open Phone.
3. Scroll to Standby mode and open. Select and open:

Left selection key Scroll to desired application, press OK.
Right selection key Scroll to desired application, press OK.

CALL SETTINGS
From Settings application:
1. Open Settings.
2. Scroll to Call and open.
3. Scroll to:

Brightness Scroll  to lighten the screen, or scroll  to 
darken the screen, then press OK.

Screen saver 
timeout

Scroll  or  to choose from 1 minute to 30 
minutes of no activity until screen saver switches 
on, and press OK.

Send my caller 
ID

Choose Set by network, Yes or No. Determines 
whether your mobile number is presented to the 
person you are calling. Network dependent.
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CONNECTION SETTINGS
Access Point Settings
Access points are sets of configurations that connect your phone 
to the Internet and other services. Your phone uses three main 
sets of access points: Multimedia (MMS), Browser, and Internet. 

Call waiting Press Options and select Check status. If 
needed, select Activate. Network will send confir-
mation message. When activated, if you are on a 
call and there is an incoming call, you can put the 
first call on hold and answer the second call. See 
Call Waiting on page 20.

Automatic 
redial

Select On to redial if the call is not connecting. 
Press  to stop automatic redialling.

Summary after 
call

Select On to display a brief summary of duration 
of last call.

Speed dialling Select On to start dialling by a press and hold of 
preset number key in standby mode. First, set up 
Speed dial keys in Settings (see Speed Dial on 
page 131). 

Anykey answer Select On to answer incoming calls by pressing 
any key except , , or .

Active 
clamshell

Select On to answer a call by opening the flip 
clamshell, and to disconnect phone calls by clos-
ing the flip clamshell. When set to Off and you 
close the flip clamshell during a call, the caller’s 
voice switches to the back loudspeaker.

Line in use This setting appears if you have subscribed to 
Alternate Line Service, in which you can have two 
different phone lines with the same SIM card. 
Select Line 1 or Line 2.

Line change This setting appears if you have subscribed to 
Alternate Line Service (see Line in use setting). 
You can disable selection of one of the phone 
lines. The PIN2 code is required to return use of a 
previously blocked line.
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Access points must be set up in order to send and receive 
multimedia and e-mail messages, use the Browser, use SyncML, 
use Device Manager, use your phone as a modem, and 
download.

Access points use data services to connect. Types of data 
services your phone can support are: Data call (Circuit switched 
data) and GPRS (Packet data). Contact your wireless service 
provider to find out about types of data technologies offered and 
subscription rates.

Some or all of your access points may be preset in the phone by 
your wireless service provider and cannot be modified. The 
access point configurations may be sent to you in a smart 
message by your wireless service provider. You may also be able 
to add new access points.

To view, edit, or add new access points, first you must obtain the 
configurations from both your wireless and Internet service 
providers to be entered into the phone.

From Settings application:
1. Open Settings.
2. Scroll to Connection and open.
3. Open Access points to view a list of existing access points.

• D icon  indicates data call. G icon  indicates GPRS 
packet data connection.

4. To add a new access point, press Options and select New 
access point > Use default settings or Use existing 
settings. Either build a new access point from preset default 
settings, or use an existing access point to edit as needed. 
• To edit an access point, press Options and select Edit.

5. Enter information in fields. Fields marked in the phone with a 
red asterisk (*) must have an entry. The bearer type you 
choose determines which fields are presented. 

* Connection 
name

Enter an easy-to-recall name if not assigned.

Data bearer Select GPRS or Data call.
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6. From main fields, press Options and select Advanced 
settings to enter:   

* Dial-up 
number 
(Data call only)

Enter access point dial-up phone number. 

Access point 
name 
(GPRS only)

Enter name supplied by service provider. 

User name Type a user name, supplied by service provider, if 
required.

Prompt 
password

To have the phone ask for the password each 
time you log on, select Yes.

Password Type in password, supplied by service provider, if 
required.

Authentication Select Normal or Secure.
Homepage Type in Internet web address of service.
Data call type 
(Data call only)

Determined by your wireless and Internet service 
providers. 

Maximum data 
speed  
(Data call only)

Choose a limit for your connection speed if you 
are charged more for higher speeds.

Phone IP 
address 

Enter IP address assigned to your phone, if static 
or dynamic. Service provider determines whether 
IP address is static or dynamic.

Primary name 
server

Type in primary domain name server IP address.

Second. name 
server

Type in secondary domain name server IP 
address.

Proxy serv. 
address

Enter the proxy server address for access point.

Proxy port num-
ber

Type in proxy port number for access point.

Use callback 
(Data call only) 

Select Yes to use dial back servers.
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GPRS Settings
From Settings application:
1. Open Settings.
2. Scroll to Connection and open.
3. Scroll to GPRS and open.
4. Open to edit:  

Callback type
(Data call only)

Select Use server no. for callback, or Use other 
no..

Callback 
number  
(Data call only)

Enter the phone number the callback server 
should use.

Use PPP
compression
(Data call only)

Select Yes to use PPP (Point-to-Point Protocol) 
compression. 

Use login script
(Data call only)

Select Yes to use login script defined in Login 
script field.

Login script 
(Data call only)

Enter the login script to be used. 

Modem 
initialisation 
(Data call only)

If desired, enter a modem initialisation string (AT 
command string).

Note: If your wireless service provider has protected some of your 
settings, you may not be able to modify them.

GPRS 
connection

Choose When needed to connect to GPRS ser-
vice only when you open an application that uses 
GPRS. After you close the application, GPRS ser-
vice will disconnect.
Choose When available to stay continuously 
connected when you are in a GPRS service area, 
in which the GPRS icon  replaces the signal 
strength icon .

Access point Choose an access point supplied by your service 
provider to use the phone as a modem to enable 
GPRS connection from a computer.
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Data Call Settings
From Settings application:
1. Open Settings.
2. Scroll to Connection and open.
3. Scroll to Data call and open.
4. Open Online time. Choose a time period to disconnect from 

the data call if there is no activity.

DATE AND TIME SETTINGS
Date and time settings can be made from the Clock menu. See 
Clock on page 129.

SECURITY SETTINGS
Phone and SIM
Your phone and SIM card have security codes that you can use to 
limit access to the phone. Keep a written record of your codes in a 
secure place.
• Enter PIN code to use phone
The PIN and PIN2 codes (4 to 8 digits), issued by your wireless 
service provider, protect your SIM card against unapproved use.

If you set PIN code request to On, then the PIN code must be 
entered each time the phone is turned on.

The PIN2 code is required to access certain wireless service 
provider services such as Fixed dialling and Call costs. If the PIN2 
code is blocked, use the PUK2 code to unblock.

The PIN and PIN2 codes affect only the current SIM card as they 
are stored in the SIM card, not the phone memory.
From Settings application:
1. Open Settings.
2. Scroll to Security and open. Open Phone and SIM.

Note: If you selected to attach to GPRS when available and are in an 
area without GPRS service, then the phone will attempt to 
connect to GPRS service periodically.
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3. Scroll to desired setting and select:   

• Enter Lock Code to Use Phone
To prevent unapproved use, you can lock the phone. When the 
phone is locked, the lock code must be entered before the phone 
can be used. The phone lock icon  indicates that the phone is 
locked.

To unlock the phone, enter the lock code. You may be able to dial 
the local emergency number and accept incoming calls when the 
phone is locked.

From Settings application:
1. Open Settings.
2. Scroll to Security and open. Open Phone and SIM.
3. Scroll to desired method and select:   

Activate Phone 
PIN

Select Yes to require entry of PIN code each time 
the phone is switched on. Requires PIN code to 
activate.

PIN code To change PIN code, enter current PIN code, then 
new PIN code twice. Press OK.

PIN2 code To change PIN2 code, enter current PIN2 code, 
then new PIN2 code twice. Press OK.

Note: If PIN or PIN2 code is entered incorrectly 3 times, the SIM card 
locks. Contact your wireless service provider for PUK or PUK2 
code (PIN unblock key code). If the PUK or PUK2 code is entered 
incorrectly 10 times, the phone will not operate; all information 
stored in the SIM card is lost and the SIM card must be replaced.

Shortcut: To lock the phone, press  and select Lock phone.

Autolock period Set the phone to lock after a time period of no 
activity. Select User defined to type in time period 
in minutes. Requires lock code to set.

Lock code To change lock code, enter current lock code, 
then new lock code twice. Record the new code in 
a safe place. The preset lock code is 12345.
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• Fixed Dialling and Closed User Group
Fixed dialling restricts outgoing calls to “fixed numbers” contained 
in SIM cards that support this feature. When switched on, dialling 
any number not on the Fixed dialling list is not allowed. Call 
diverting and sending messages to any numbers not on the list 
are also not allowed. The PIN2 code is required to set up and use 
this feature.

Once you enter Fixed dialling, press Options and select New 
contact or Add from Contacts to add a phone number to the 
Fixed dialling list. You can also call, edit, and delete numbers in 
the Fixed dialling list.

Some wireless service providers offer Closed User Group feature, 
which allows the phone to make and receive calls only from 
specific groups. The groups are set up with your wireless service 
provider at the time of your subscription purchase. 
From Settings application:
1. Open Settings.
2. Scroll to Security and open. Open Phone and SIM.
3. Scroll to desired method and select: 

Lock if SIM 
changed

To prevent the phone from being used if an 
unknown SIM card is inserted, select Yes.

Caution: If you change the lock code then cannot recall it, your wireless 
service provider cannot identify the code. The phone must 
then be reset at an authorised service centre. 

Fixed dialling Enter PIN2 code. Press Options and select New 
contact or Add from Contacts to create the fixed 
dialling list. Press Options and select Activ. fixed 
dialling to activate the service.

Closed user 
group

Select Default to activate the service to the 
default group previously set up with your wireless 
service provider. Select On to activate another 
group set up previously.
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Certificate Management
Certificates are attachments to electronic messages used to verify 
senders and recipients of data over nonsecure networks, such as 
e-mail servers or the Internet. Two types of certificates your phone 
stores are authority and personal. 

Authority certificates are downloaded to your phone and are used 
to check server certificate signatures and to guarantee that the 
certificate is issued by a certification authority (CA).

Personal certificates are issued to you by a certification authority.

Certificates are valid for only a fixed time period and must be 
renewed periodically. To renew, contact the certificate issuer.

Before downloading or sending confidential information, check the 
digital signature and validity period of the browser gateway or 
server on the certificate.

The phone will issue a note if the browser or server identity is not 
authentic, or if you do not have the correct certificate in your 
phone.

• View Certificates
From Settings application:
1. Open Settings.
2. Scroll to Security and open.
3. Scroll to Certif. management and open.

• A list of authority certificates displays.
4. Press Options and select Certificate details.

Confirm SIM 
services

Select Yes to view confirmation messages sent 
between your phone and the network when you 
are using SIM application tool kit services.

Delete server You can reset the trusted provisioning server set-
ting if you have received settings in a message. 
Contact the service provider from which you wish 
to receive new settings.
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• A list displays with details such as issuer, subject, validity 
period, certificate location, certificate format, algorithm, 
serial number and fingerprint. 

• Authority and personal certificates will show different 
information. If the personal certificate is on an outside 
server, it will have different details.

5. Scroll  to view personal certificates if available.

• Trust Settings
Check whether certain applications (Browser, Application 
Manager, or Internet) can use a selected certificate.
From Settings application:
1. Open Settings.
2. Scroll to Security and open.
3. Scroll to Certif. management and open.
4. Scroll to an authority certificate, press Options and select 

Trust settings.
5. For each application, select Yes to enable the certificate to 

verify software, servers, or browser sites. Select No to disable 
the certificate from verifying software, servers, or browser 
sites. 

CALL DIVERT
Divert incoming calls (voice, data) to another number. Network 
dependent service.

Check status of Call Divert
From Settings application:
1. Open Settings.
2. Scroll to Call divert and open.
3. Press Options and select Check status. Network will send 

current status message. 

Note: Before you change any trust settings, be sure that you trust the 
certificate owner and have verified that the certificate belongs to 
the listed owner.
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Activate Call Divert
From Settings application:
1. Open Settings.
2. Scroll to Call divert and open.
3. Select one or more: All voice calls, If busy, If not answered, 

If out of reach, If not available, All fax calls or All data 
calls.

4. Press Options and select Activate. 
5. Select whether calls shall be diverted To voice mailbox or To 

other number.
6. Enter the phone number and press OK.

• Press Find to go to your Contacts to select a number.
7. Network will send confirmation message. 

To cancel call diverts, press Options and select Cancel or 
Cancel all diverts.

CALL BARRING
Call barring restricts certain types of incoming and/or outgoing 
calls, using a password furnished by your wireless service 
provider. Network dependent service.

Check Status of Call Barring
From Settings application:
1. Open Settings.
2. Scroll to Call barring and open.
3. Press Options and select Check status. Network will send 

current status message. 

Activate Call Barring
From Settings application:
1. Open Settings.
2. Scroll to Call barring and open.
3. Select Outgoing calls, International calls, International 

calls except to home ctry., Incoming calls, or Incoming 
calls when abroad.
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4. Press Options and select Activate. 
5. Enter Barring password and press OK.
6. Network will send confirmation message. 

To cancel call barrings, press Options and select Cancel or 
Cancel all barrings.

To change the call barrings password, press Options and select 
Edit barrings passw.. Enter the password furnished by your 
wireless service provider. Enter, then verify the new password.

NETWORK SETTINGS
When you are not in your home country or region, you may be 
able to use a network which you are not directly subscribed to. 
This is called roaming.

Select a Network
From Settings application:
1. Open Settings.
2. Scroll to Network and open.
3. Set Operator selection to Automatic to have the phone 

automatically select a network when roaming. Set Operator 
selection to Manual to select a network yourself from the list, 
which are networks available in your current area that have a 
roaming agreement with your home network.

• Using a Micro Cellular Network
When the phone is using a micro cellular network (MCN), it can 
display an MCN indicator in standby mode. Set Cell info display 
to On to switch on this indicator if you enter an MCN.

ENHANCEMENT SETTINGS
When you attach a headset or Bluetooth® headset enhancement 
to the phone, you can set the ringtone (General, Silent, Meeting, 
Outdoor, Pager) that the phone will use when the enhancement is 
attached.

Note: Local laws may not permit roaming in your home region.
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See Ringtones on page 112 to learn about ringtones.

From Settings application:
1. Open Settings.
2. Scroll to Enhancement and open.
3. Scroll to Headset or BT Accessory and open.
4. Select the Default profile settings (Active profile, General, 

Silent, Meeting, Outdoor, or Pager).
5. Set Automatic answer to On if you want the phone to 

automatically answer calls when the enhancement is 
attached.

• Enhancement in use
Select which enhancement is attached to the phone.

From Settings application:
1. Open Settings.
2. Scroll to Enhancement and open.
3. Open Enhancement in use and select Headset or BT 

Accessory. 

CLOCK
Choose a digital or analogue clock to appear in standby mode. 
Set alarm clock and alarm tone to remind you of events. If the 
phone is off when alarm time is reached, the phone switches on 
and the alarm tone sounds.

SET TIME AND DATE
From Settings application:
1. Open Clock.
2. Press Options and select Settings.
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3. Scroll to the desired setting and open; or press Options and 
select Change:  

SET ALARMS
From Settings application:
1. Open Clock.
2. Press Options and select Set alarm.
3. Enter alarm time by either typing in numbers or scrolling . 

Scroll  to move among fields. Press OK.

Time Either type in numbers or scroll  to enter time. 
Scroll  to move among fields.

Date Enter date using same method as time entry.
Date format Select format where mm = month, dd = date, yyyy 

= year.
Date separator Choose from symbols [ .  :  /  - ].
Time format Choose 12-hour or 24-hour.
Time separator Choose symbols  :  or  ..  
Clock type Choose Analogue or Digital.
Clock alarm 
tone

To choose a tone, scroll through list of ringing 
tones. To hear the tone, highlight the tone name 
and wait. To stop the tone, press any key. To 
select a tone, highlight the tone name and press 
Select.

Auto time 
update

Select On to update time from the network. Avail-
able only if network supported.

GMT offset If Auto time update is not available, select a time 
zone, which is offset to GMT time (for example, 
+05:00 or -05:00). 

Daylight-saving Select On to add an offset of +01:00 to the current 
GMT time.

Note: GMT offset and Daylight-saving settings are available only if 
Auto time update is set to Off.
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If an alarm is already set, you can reset or remove the alarm by 
pressing Options and selecting Reset alarm or Remove alarm.

When the Alarm Rings
When alarm time occurs; the alarm tone rings, the backlight 
flashes, and a message displays.
To turn off alarm, press Stop. 
To quiet the alarm indicators for 5 minutes, press Snooze or any 
key. 
• If the phone is switched off, the phone temporarily switches on 

and the other alarm indicators take place. 
• If you press Snooze, the phone automatically switches off 

for 5 minutes, then the alarm rings again (maximum 5 
times). 

• If you press Stop, you are asked whether you wish to 
switch the phone on.

The alarm is deleted when you press Stop. If you wish to have an 
alarm for the next day, you have to set the alarm again.

SPEED DIAL
Set phone to quickly dial frequently called numbers by pressing 2 
keys.

ASSIGN A SPEED DIAL NUMBER
From Settings application:

Caution: Do not press Yes to switch phone on when you are in an 
aircraft, near sensitive medical equipment, at a refuelling point 
or when it may cause interference or danger.
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1. Open SpeedDial.
2. A grid showing numbers 1 - 9 appears.

• If a digit is replaced by an icon, then 
the corresponding key has been 
reserved by your wireless service 
provider to dial a special number, for 
example, to dial the voice mailbox 
number.

3. Scroll to a number, press Options and 
select Assign.

4. Scroll to the desired Contacts card and press Select. 
5. Scroll to the desired number and press Select.

CALL A SPEED DIAL NUMBER
To call a preset speed dial number, choose a method:
• From standby mode, press the corresponding number key  - 

 and press .
• From the Speed dial menu, scroll to desired number and press 

, or press Options and select Call.

CHANGE, REMOVE, OR VIEW SPEED DIAL 
NUMBERS
From Settings application:
1. Open SpeedDial.
2. Scroll to desired number on grid.
3. Press Options and select Change, Remove, or View 

number.

VOICE COMMANDS
Press and hold , say “Voice Dial”, then say a name in your 
Contacts list and the phone will dial the number. Press and hold 

, then say “open Messages” or “open Camera” and your 
phone will go directly to the application. 
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START VOICE COMMANDS
1. Press and hold . 

• or from Settings application, open Voice.
2. You will hear the prompt to “Say a command”.
3. Say one of the choices listed on the phone that you wish to 

use:  Voice Dial, Name Lookup or Open (application).

VOICE DIAL
Dial by Name
To dial by saying the name of the person you wish to call: 
1. Press and hold . 
2. After the prompt to “Say a command”, say “Voice Dial”.
3. After the prompt to “Say the name or number”, say the full 

name of a person in your Contact list, including first name and 
last name.

4. The name is repeated, and the phone will begin dialling.
• If the name has more than one number in the Contact 

entry, say the title of the desired number.

Dial by Number
To dial by saying the phone number: 
1. After the prompt to “Say the name or number”, say the digits 

of the phone number you wish to dial, without pausing 
between digits.

2. If the phone recognises the number, it is repeated and the 
phone will begin dialling.

If the phone is not sure of the number, it displays a list of choices 
and prompts “Did you say...?” and states the first choice.
• If the number is correct, say “Yes”. If the number is not correct, 

say “No” to hear the next possible match, or scroll and select 
the correct number on the list.

NAME LOOKUP
Look up the Contact information for a person in your Contact list, 
without automatically dialling the phone number.
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1. Press and hold . 
2. After the prompt to “Say a command”, say “Name Lookup”.
3. After the prompt to “Say the name”, say the full name of a 

person in your Contact list, including first name and last name.
4. The Contact entry appears on the screen.

OPEN APPLICATION
Open an application by saying “Open”, then say the name of the 
desired application.
1. Press and hold . 
2. After the prompt to “Say a command”, say “Open”, then say 

the name of the application, for example, “Messages”.
3. The application opens.

See Voice Commands Settings to choose applications to open.

VOICE COMMANDS SETTINGS
1. Press and hold . 
2. After the prompt to “Say a command”, press Settings and 

select from:
Digit Dialing If the phone cannot consistently recognise num-

bers that you are saying, select Adapt Digits to 
make recordings to teach the system your voice. 
Select Reset Digits to restore the original recog-
nition software.

Sensitivity If the phone cannot recognise most of your com-
mands, change sensitivity toward Reject Less. If 
the phone recognises too many mismatches, 
change sensitivity toward Reject More.
Select Commands or Names. Then scroll up or 
down to change the setting.

Choice Lists Choose whether the phone presents choices 
when the phone does not recognise your com-
mand.
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PRINT BOY SETUP
PrintBoy Setup works with your QuickOffice menu to print your 
QuickOffice documents wirelessly from your phone to supported 
printers.

From Settings menu:
1. Open PB Setup.
2. On the Drvrs tab is a list of supported printer drivers. Scroll to 

desired printer.
3. Press Options and select Configure. Select from: 

Sound Switch on or off the playback of prompts, names 
and digits. Select Name Settings to change the 
speed or volume of name playback.

Language Choose from the list of languages that the soft-
ware will use for audio prompts, text screens, and 
your voice recognition.

Application 
Launcher

Check to select applications from the list to open 
using Open Applications.

Contacts 
Update

Each time Voice Commands is opened, it checks 
your Contacts list for name additions or edits, and 
if appropriate, automatically reloads the list. If the 
list is large, the reload requires more time. Select 
Configure to choose Automatic or Manual reload-
ing. 

About Copyright information about the voice recognition 
software.

Communication Select the method to send data to the printer.
Paper Size Choose a paper size.
Left margin Choose desired left margin measurement..
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4. After the printer is configured, scroll , press Options and 
select:

ABOUT
View copyright information about the phone and software used on 
the phone.

From Settings application:
1. Open About.

Test Print Send a test print.
Bluetooth > Select Find Printer to pair with the printer.
Set as Default From the Drvrs tab, set the highlighted printer as 

default.
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TOOLS
Tools allows you to take care of a variety of tasks in one place. 
Use the Calculator to make quick calculations. Use the Converter 
to convert currencies and measurements. Jot down quick notes 
on the Notepad. Record short voice clips using Recorder. See 
your files in one place using File Mgr and manage data stored on 
the miniSD Card. Install Java™ MIDlet (Mobile Information Device) 
applications using App Mgr.

Tools menu contains these main options: 

CALCULATOR
Perform simple mathematic calculations using the calculator.
From Tools application:
1. Open Calculator.
2. A virtual calculator displays. Type in first 

number of calculation, which appears in 
field near bottom of screen. 
• To enter a decimal, press .
• To erase digits, press .
• To change number to positive or 

negative, scroll to positive/negative 
button and select.

3. Scroll  or  to move box to desired 
mathematic action, then press  to select.

4. Enter the next number. To get result, scroll to equal button and 
select.

Calculator Converter Notepad

Recorder miniSD To-do

App Mgr File Mgr Photolight

SIM Tool Kit
(optional)
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• To view the last result, press Options and select Last 
result.

The left side of the screen serves as a “tape” to record your 
calculations. Use the double up and double down arrow buttons 
on the screen to scroll up and down the “tape”.

To save a number in calculator memory, select the MS (Memory 
Save) button. To recall the number, select the MR (Memory 
Recall) button.

CONVERTER
Convert a variety of measurements such as world currencies, 
area, length, volume, temperature, power, and velocity.

Set the Base Currency
From Tools application:
1. Open Converter.
2. If the Type field is not set to Currency, open and change to 

Currency.
3. Press Options and select Currency rates. A list of world 

currencies (3 letter currency codes) appears with the base 
currency (if set) noted at the top of the screen.
• Most commonly used codes are listed first. They are USD 

= U.S. dollar; EUR = European Union euro, GBP = British 
pound sterling, JPY = Japanese yen.

4. Scroll to the desired currency code you wish to set as the 
base, press Options and select Set as base curr..
• Any rates entered earlier are reset to zero.

5. Scroll to desired currency codes and type in currency 
exchange rates, based on your newly set base currency = 1.
• To enter a decimal, press .

6. Press Done.

Shortcut:To automatically add, subtract, multiply, or divide, enter first 
number. Press  until you reach desired numeric 
operation; stop pressing , and the operation is inserted.
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7. Continue with step 3 in Convert Measurements on page 139.

Convert Measurements
From Tools application:
1. Open Converter.
2. Open the Type field, scroll to desired measurement type and 

press OK.
3. If converting Currency, press Options and 

select Change currency..
• If converting Currency, press Options 

and select Set currency.
4. Scroll to the desired unit to convert 

FROM, and press OK.
5. Scroll to second Unit field, press Options 

and select Select unit. 
• If converting Currency, press Options 

and select Change currency.
6. Scroll to the desired unit to convert TO, and press OK.
7. Scroll to the first Amount field; press  to erase zero. Type 

in desired unit amount to convert. 
• To enter a decimal, press .
• To enter + and - (for temperature) and E (exponent) 

symbols, press .
Converted amount automatically displays in second Amount 
field.

NOTEPAD
Jot down quick notes into the notepad. Open and edit simple text 
documents (.txt) saved from text attachments sent using 
messaging and chat applications. 

Note: To edit the currency rates, press Options and select Currency 
rates.

Note: You can also convert amounts in reverse. Type in amount in 
second field; converted amount automatically displays in first 
field.
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From Tools application:
1. Open Notepad.
2. Press Options and select New note. 
To Send a Note
From Tools application:
1. Open Notepad.
2. Press Options and select Send > Via text message, Via 

multimedia, Via e-mail, Via Bluetooth or Via infrared. 
3. To complete text messages, see page 50; or multimedia 

messages on page 51; or E-mail messages on page 53; or 
Bluetooth® on page 102; or Infrared on page 104.

RECORDER
Record voice memos up to 1 minute in length. You can also 
record a two-way phone conversation. Recorded sound clips are 
stored in .amr format.

Record a Sound Clip
From Tools application:
1. Open Recorder.
2. Press Options and select Record sound clip.
3. Begin speaking into microphone. Press Stop to stop 

recording.
• Seconds counter bar near bottom of screen and Length 

counter both keep track of seconds elapsed.
4. To rename the sound clip to find it in the list, press Options 

and select Rename sound clip.

Play Back a Sound Clip
If sound clip was just recorded, go to step 4. Or from Tools 
application:
1. Open Recorder.
2. Press Options and select Go to Gallery.
3. Open desired folder, then scroll to desired sound clip and 

open.
4. Select on screen Play button.
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• Volume control - Scroll  to adjust volume. Note speaker 
icon and volume steps in upper part of screen.

• To select buttons on screen, scroll  or  to move box to 
button and press : 

To play a sound clip during a call, open the sound clip from its 
current location and play. The other person hears the sound clip.

Record a Conversation

1. During a phone conversation, press  and follow steps 1 to 
3 in Record a Sound Clip on page 140.

2. The conversation records.
3. Press Stop to stop recording.

Send a Sound Clip
If sound clip was just recorded, go to step 4. Or, from Tools 
application:
1. Open Recorder.
2. Press Options and select Go to Gallery.
3. Open desired folder, then scroll to desired sound clip.
4. Press Options and select Send > Via multimedia, Via e-

mail, Via Bluetooth or Via infrared.
5. To complete multimedia messages, see page 51; or E-mail 

messages on page 53; or Bluetooth® on page 102; or Infrared 
on page 104.

Recorder Settings
From Tools application:
1. Open Recorder.

Play: Pause: Rewind:

Stop: Fast forward: Record:

Caution:You are responsible for the security of a recorded message. 
Ask for the other party’s consent before recording, and abide 
by local voice recording laws.
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2. Press Options and select Settings. Scroll to:  

Use Recording as a Ringing Tone
To use a recording as a ringing tone, record a sound clip as 
described in Record a Sound Clip on page 140.

The new sound clip automatically appears in the Ringing tone lists 
in the Ringtones, Contacts, Clock, and Calendar alarm 
applications. To assign ringing tones see Ringtones on page 112, 
Assign a Ringing Tone on page 38, and Set Alarms on page 130.

Memory in use Store recordings in Phone memory or miniSD 
Card.

Default speaker Choose Loudspeaker or Handset.
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miniSD CARD
Backup your phone memory onto the miniSD memory card. 
miniSD Cards can be installed into the standard size memory card 
socket of other devices using the miniSD Card adapter (see Using 
miniSD Card and miniSD Adapter on page 144). Data file size of 
miniSD Card may vary with current availability. 

Remove miniSD Card
1. Press , scroll to Eject miniSD Card and press OK. Wait 

for file saving or copying process to finish before removing 
miniSD Card.

2. Continue with Removing miniSD Card on page 6.

Format, View Details of miniSD Card

Backup Files

From Tools application:
1. Open miniSD. A list indicating name, storage capacity, 

storage used, and storage free displays
2. Press Options and select:

 

Warning:Do not format a miniSD Card that contains important software 
as this destroys all data on the miniSD Card.

Remove miniSD 
Card

Saves data and closes applications before eject-
ing miniSD Card.

Backup phone 
mem.

Backup the phone contents to the miniSD Card.
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Password in some miniSD Cards
Some brands of miniSD Cards can be locked from unapproved 
use by entering a password. If you insert a miniSD Card with 
locking capability into your phone, the following option items will 
appear.

From Tools application:
1. Open MiniSD Card. 
2. Press Options and select:

Using miniSD Card and miniSD Adapter
By inserting the miniSD Card into the miniSD adapter, you can 
use the miniSD Card in an SD memory card compatible personal 
computer. Back up data and print images using a printer.

To insert the miniSD Card into the miniSD adapter:

Restore from 
card

Restore earlier backed up miniSD Card data to 
the phone memory.

Format miniSD 
Card

Format other brand miniSD Cards if needed 
before first use.

miniSD Card 
name

Write a name or title for the miniSD Card.

Memory details View number of bytes stored in separate applica-
tions such as Calendar, Messages, documents. 
Also view total memory in use and free memory.

Set password Enter a password to use to lock the miniSD Card. 
Thereafter, the password must be entered to use 
the miniSD Card in any device.

Remove pass-
word

Removing the password unlocks the miniSD 
Card, and it can be used in another device without 
a password.

Change pass-
word

Change locking password for this miniSD Card.

Unlock miniSD Enter the password to unlock the miniSD Card.
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1. On miniSD adapter, move 
lock tab into unlocked 
position.

2. Slide miniSD Card in with 
notched corner entering 
the left side of the miniSD 
adapter first into the pocket 
until it clicks.

3. Follow manufacturer’s 
instructions for inserting an 
SD card in the compatible personal computer and accessing 
the data.

WRITE-PROTECT miniSD CARD
• To protect important data, move write-protect switch to Lock 

position. The miniSD Card is write-protected and you cannot 
write, save, delete data, or format the card.

• To write data to the miniSD Card, move write-protect switch to 
unlocked position.

TO-DO LIST
Make a list of tasks, and set a deadline and priority for each.

Create a New To-do Task
From Tools application:
1. Open To-Do.
2. Press Options and select New to-do note.
3. Enter information in fields:

4. Press Done to save.

Subject Description of task or subject.
Due date Assign a due date.
Priority Open and select High, Normal or Low.

Note: In the list of tasks, ! icon means High priority task; - icon means 
Low priority task.

MiniSD Adapter with 
miniSD Card inserted

Lock

Write-protect 
switch

MiniSD Card

MiniSD Adapter
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Edit and Mark To-do Tasks
From Tools application:
1. Open To-Do.
2. Scroll to the desired task.

• To edit, open task and edit information in fields as desired. 
• To mark the task as completed or to restore task, press 

Options and select Mark as done, or Mark as not done.

APPLICATION MANAGER
The Application Manager allows you to install and manage both 
Java™ MIDlet (Mobile Information Device) applications and 
device software installation files. Examples include games, secure 
information storage, and compression software. You can also 
view and manage Authority and Personal certificates (see 
Certificate Management on  page 125).

View Details of Application
From Tools application:
1. Open App Mgr..
2. Scroll to desired application installation file.

• Files with extension .sis are device software installation 
files. Files with extensions .jad or .jar are Java™ 
applications.

3. Press Options and select View details.
• A list displays with details such as name, version, type, 

certificate and signature details, trust status for MIDlets, 
application size, and application supplier.

View Certificate
From Tools application:
1. Open App Mgr..
2. Scroll to desired application installation file.
3. Press Options and select View certificate.

Note: A checkmark within a box means task is completed. A blank box 
means task is unfinished.



   147

• A list displays with details such as issuer, subject, validity 
period, serial number, and fingerprint.

See Certificate Management on page 125.

Install Application or Software
Your phone supports installation of software and applications 
suitable for the Symbian™ operating system. Because these files 
are usually large and compressed, be sure to reserve enough 
time and phone memory for the entire installation procedure.
From Tools application:
1. Open App Mgr..
2. Scroll to desired application installation file.
3. Press Options and select Install.

If there is no digital signature or certificate attached to the 
software or application, the phone issues warnings of the risks of 
installing without verifying the source. You should only install 
software or applications from sources that you have personally 
verified and of which you are absolutely sure.

You will see messages asking if you wish to continue or cancel 
during different phases of the installation process.

If the installation process is cancelled for some reason, such as 
the phone runs out of memory, then the installation is not 
complete, or partial. To complete the partial installation, either 
delete the partially installed application, or reinstall the 
application.

If there are problems with installation, you can view the installation 
log or send the installation log to a help desk for troubleshooting. 
Press Options and select View log or Send log.

Remove Application or Software
From Tools application:
1. Open App Mgr.

Note: Panasonic is not responsible for the performance of downloaded 
content or possible corruption of phone software.
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2. Scroll to desired application installation file.
3. Press Options and select Remove.

FILE MANAGER
Organise and manage files stored in the phone memory and on 
the miniSD Card. It’s an easy way to find files and folders.

View Folders and Files
From Tools application:
1. Open File Mgr.
2. A list of folders and files stored in the 

phone memory appears. Some folders 
may have sub folders, for example, 
Images folder has two sub folders - 
Picture msgs. and Wallpapers. Files that 
have not been stored in a folder are 
listed after the folder names.
• Scroll  to view folders and files 

stored on the miniSD Card.
3. Scroll to desired folder or file and open.

Find Folders and Files
Type letters or keywords in a search box  to find a folder 
or file.
From Tools application:
1. Open File Mgr.
2. Press Options and select Find.
3. Choose to look in the phone memory or miniSD Card.
4. Type in the keyword to find, or just type in a few letters, and 

press Find.
5. After a brief period of searching, a list of files and folders 

containing the keyword displays.

Note: Removing a software application may cause you to not be able to 
view documents created with that software, and other software 
may not work if it relies on the removed software.
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6. The list is sorted from closest match first to farthest match 
last. Folders and files with the same name appear with folder 
before file.

Manage Folders and Files
From Tools application:
1. Open File Mgr.
2. Press Options and select:

Send Files
From Tools application:
1. Open File Mgr.
2. Open desired folder, then open file.

Open Open the selected folder or file.
Delete Delete the selected folder or file.
Move to folder Move selected item to another folder.
Copy to folder Copy selected item to another folder, leaving the 

original in its current place.
New folder Create a new folder.
Mark/Unmark Mark or unmark several files at once. Not avail-

able for folders.
Rename Change name of item. Default folders cannot be 

renamed.
Receive via 
Infrared

To receive a file via infrared, see page 104.

View details View name, format type, date and time modified, 
size in bytes or kilobytes (if item is a folder, size is 
total of all files and folders inside the folder), 
whether it is a default folder, number of sub fold-
ers, and number of files.

Memory details View number of bytes stored in separate applica-
tions such as Calendar or Messages. Also view 
total memory in use and free memory. View phone 
memory on phone memory tab, or scroll  for 
miniSD Card memory.
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3. Press Options and select Send > Via multimedia, Via e-
mail, Via Bluetooth, or Via infrared.

4. To complete multimedia messages, see page 51; or e-mail 
messages on page 53; or Bluetooth on page 102; or Infrared 
on page 104.

PHOTOLIGHT
Light up your subject before snapping a 
picture or recording a video clip. To turn 
on the Photolight;
1. From standby mode, press and hold 

.
2. Open Camera and continue with 

Take a Picture on page 71. To 
record a video clip, continue with 
Record a Video Clip on page 87.

To switch off Photolight, return to 
standby mode, then press and hold 

.

Or, you can switch on or off Photolight from Tools application:
1. Open Photolight.
Unlike a camera flash, the Photolight does not flash. Photolight 
remains on until you switch it off.  

Note: The phone may not allow you to copy, modify, transfer or forward 
some copyrighted images, ringtones or other content.
Send is not available if a folder or playlist is highlighted.

Note: Do not use the Photolight near the eyes. The Photolight is 
intended as an auxiliary light source for shooting photos in dim 
areas. It does not produce the intense light of a typical camera 
flash.

Battery note:Keeping Photolight switched on consumes battery power 
more rapidly. To conserve battery power, switch off 
Photolight when not in use.

Indicator 
Light and 
Photolight
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Use Photolight as a Flashlight
The Photolight can be switched on to use as a small flashlight.
1. In standby mode, press and hold . The Photolight 

switches on.

To switch off the Photolight, return to standby mode, then press 
and hold .

• Whether or not you close the flip, the Photolight remains on 
until you switch it off. 

• The Photolight also switches off when the phone is switched 
off. 

SIM TOOL KIT
The SIM Tool Kit allows applications existing on the SIM card to 
interact and operate with your phone. These applications, stored 
in the SIM memory, are Value Added Services. Your network 
operator can configure your SIM card with applications that can 
be seen on your phone as additional menu items. 

Contact your network operator for further information.
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CALL LOGS
Check your recent missed calls, received calls, and dialled 
numbers. View the amount of data sent and received via GPRS. 
View details for each incoming and outgoing communication 
event such as voice calls, text messages, and GPRS 
connections.
These features are SIM card dependent.

MISSED CALLS, RECEIVED CALLS, AND 
DIALLED NUMBERS
When you miss an incoming call, a missed call icon  and a 
note displays on the standby screen. Press Show to view the 
details of the missed call.
From Call Logs application:
1. Open Recent calls.
2. Open Missed calls, Received calls, or Dialled nos.. 
3. List of last 20 calls appears with caller or dialled phone 

number (or name if entered in Contacts), date and time of call. 
Also, scroll  or  to view lists.

To clear all Recent calls lists (Missed calls, Received calls, and 
Dialled nos.) at once, open Recent calls, then press Options and 
select Clear recent calls.

Call or Add to Contacts
Make a call using a number from the recent calls lists, or add the 
number to your Contacts list.
From Call Logs application:
1. Open Recent calls.
2. Locate desired number in Missed calls, Received calls, or 

Dialled nos., and highlight.

Shortcut: To view the Dialled nos. list from the standby screen, press 
.
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3. Press Options and select:

CALL DURATION
Check duration of last call and accumulated duration of dialled 
calls, received calls, and all calls. 
From Call Logs application:
1. Open Call duration.
2. Scroll to view duration of Last call, Dialled nos., Received 

calls, and All calls (since last counter reset).
• Times indicated in hours:minutes:seconds.

To clear all Call duration lists (Last calls, Dialled nos., Received 
calls and All calls) at once, press Options and select Clear 
timers.

To separate Call duration lists into summaries for each of both 
lines, Line 1, or Line 2, press Options and select Filter timers.

GPRS DATA COUNTER
View the amount of data in kilobytes sent and received by the 
phone via GPRS data packets, for example, WAP pages, e-mail 
messages, downloaded ringtones and applications.

From Call Logs application:

Call Dial the number.
Create 
message >

Select Via text message or Via multimedia to 
create a new message addressed to the number.

Use number Use the number as a base to edit for dialling a 
similar number.

Clear list Erase all numbers from selected list.
Add to 
Contacts >

Create new Contacts card or Update existing 
card using the number.

Note: Actual times invoiced from your wireless service provider for calls 
and services may vary from the call timers depending on number 
of network features purchased, when billing begins and ends, 
billing rounding off, etc.
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1. Open GPRS counter.
2. All sent data and All receiv. data amounts display in 

kilobytes.

To clear the GPRS counter, press Options and select Clear 
counters. Enter the phone lock code and press OK. 
See Security Settings on page 122.

CALL LOGS SETTINGS
From Call Logs application:
1. Press Options and select Settings. 
2. Scroll to select:

GENERAL CALL LOGS
View details for each incoming and outgoing communication 
event such as voice calls, text messages, and GPRS 
connections.

From Call Logs application:
1. Scroll  to General Logs tab .
2. A list of communication events displays. Up arrow icon  

indicates outgoing or sent; down arrow icon  indicates 
incoming or received events.

3. Press Options and select:

Log duration Choose from No log, 1 day, 10 days, or 30 days 
to store call information in the logs.

Show call dura-
tion

Select Yes to switch on a time elapsed counter to 
display during a call.

View details Scroll to desired event to view details such as 
direction (in/out), type (voice, data, etc.), duration 
(for calls).

Clear log Clear all events from the log.
Filter Separate events into a list by type such as Outgo-

ing, Incoming, Voice calls, Data calls.
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Add to Con-
tacts >

Scroll to desired event to Create new Contacts 
card or Update existing card using number or 
address.
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QUICKOFFICE
Store your Microsoft® Word, Excel, and PowerPoint® documents 
on your phone. Edit them right on the phone, then beam or send 
the new documents to another device, or save them to the miniSD 
Card.

VIEW DOCUMENTS
From Quickoffice application:
1. Scroll  to Quickword, Quicksheet, or Quickpoint documents 

tabs.
2. A list of documents in phone memory appears. 
3. Press Options and select:

Note: For customer support and more information on Quickoffice, visit 
www.quickoffice.com.

Open Open highlighted file.
New Create a new document.
Browse Select the memory to browse. Open folders 

as needed to view documents
File management > Sort files to sort by name, size, date or ext., 

or Scan location to Scan default, Scan 
mail, or Scan all.

Refresh Refresh the list view.
Properties View details of highlighted file.
Send as Send file Via multimedia, Via e-mail, Via 

Bluetooth, Via infrared.
Delete Delete highlighted file.
About product View copyright information about the soft-

ware.
EULA View software license agreement

Note: You can also view and move your documents from File Manager 
(see page 148).
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VIEW MICROSOFT® WORD DOCUMENTS
Documents open in read-only full screen view. You must press 
Options and select Edit mode to make edits to a document.

Scroll  to move one line at a time or scroll  to move one page 
at a time.

Go to shortcuts (percentage through the document):  Press  
for  20%,  for 30%, etc.,  to go to beginning.

Press Options and select: 

EDIT MICROSOFT® WORD DOCUMENTS
1. From an open document, press Options and select Edit 

mode.
2. Save the document with a new file name.
3. Scroll through the document using:

 - move down one line   - move up one line
 - move left one space   - move right one space

To highlight text to apply a format, press and hold , then 
scroll  or . The text will highlight. For more text editing options, 
see Entering Text on page 24.

 

Edit mode Go to Edit mode.
Search > Choose Find, Find Next or Replace. Enter text to 

be located in Find field. In other fields, scroll  to 
choose a search range. Then press Find. 

Goto > To go to desired place in the document, choose 
Top, Percent, or Bottom.

Zoom > Zoom out, Zoom 100%, or Zoom in document 
by desired amount.

Autoscroll Automatically scroll document line by line. Scroll 
 to increase speed, scroll  to decrease speed.

Print Print document by sending it via Multimedia, 
Bluetooth® or infrared.
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Press Options and select:    

VIEW MICROSOFT® EXCEL DOCUMENTS
Documents open in read-only full screen view.
Scroll through the document using:

 - move down one cell   - move up one cell
 - move left one cell   - move right one cell
 - toggle between view mode and edit mode

Press Options and select: 

View mode Go to View mode.
Font Choose a font name and size to apply to 

highlighted text.
Style > Choose bold, italic, or underline to apply to 

highlighted text.
Alignment > Choose left, centre, or right alignment to apply to 

highlighted text.
Colour Choose a colour to apply to highlighted text.
Bullet Apply bullet to highlighted text.
Search > Choose Find, Find Next or Replace. Enter text to 

be located in Find field. In other fields, scroll  to 
choose a search range. Then press Find. 

Print Print document by sending it via Multimedia, 
Bluetooth® or infrared.

Note: Tables, pictures or embedded objects in Microsoft® Word 
documents cannot be displayed on the phone.

Edit Cell Edit highlighted cell.
Worksheets > Select, insert, rename or delete worksheets.
Toggle Full 
Screen

Toggle between full screen and reduced screen.

Zoom > Choose a size to zoom document.
Freeze > Freeze Row, Column or Both for the highlighted 

cell.
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EDIT MICROSOFT® EXCEL DOCUMENTS
Documents open in read-only full screen view.

 - toggle between view mode and edit mode

In edit mode:
 - move cursor left within a cell   - move cursor right within a cell

To select cells, press and hold , then scroll , ,  or . 

Press Options and select:   

Adjust Column 
Width

Scroll  to adjust column width.

Clipboard > Choose Cut, Copy, Paste or Select All to apply 
to highlighted cells.

Search > Choose Find, Find Next or Replace. Enter text to 
be located in Find field. In other fields, scroll  to 
choose a search range. Then press Find. 

Properties Set cursor movement after entry and toggle auto-
recalculations.

Print Print document by sending it via Multimedia, Blue-
tooth® or infrared.

Accept Text Edit Enter the edit.
Revert Text Edit Revert to previous cell content.
Operators > Choose from list of math operators and commonly 

used symbols.
Functions > Choose from list of spreadsheet functions.
Range Select Select a range of cells by highlighting.
Formatting > Choose from list of formatting.
Alignement > Choose Default, Left, Center or Right to apply to 

highlighted cells.
Justify > Choose Default, Left, Centre or Right to apply to 

highlighted cells.
Font  Apply Bold or Underline font style.
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VIEW MICROSOFT® POWERPOINT® 
DOCUMENTS
Documents open in outline view.
Scroll  to move between outline, notes, slide, and thumbnail 
views.

Navigation Shortcuts

Colour > Apply colour to Font or Cell.
Style Choose from list of text and number styles.
Clipboard > Choose Cut, Copy, Paste or Select All to apply 

to highlighted cells.
Clear Clears highlighted cell formatting, formula 

content, or both.
Print Print document by sending it via Multimedia, 

Bluetooth® or infrared.

Note: Macros, pictures, graphs or embedded objects in Microsoft® 
Excel documents cannot be displayed on the phone.

View Action Keypress
Outline, Notes, 
Slide

Toggle between full 
screen and partial screen

Slide view full 
screen

Zoom out
Zoom in
Fit to screen

Outline, Notes, 
Slide

Previous slide
Next slide

 or 
 or 

Thumb
(4 slides per page)

Page up
Page down
Next slide
Previous slide
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Options Menu
The Options menu varies in an open PowerPoint® document, 
depending on which of the 4 views you are using. 

Press Options and select: 

 

Outline Collapse slide
Expand slide
Collapse all
Expand all
Edit slide

Toggle Screen Toggle screen in outline, notes, and slide view.
Edit > In outline view, you can edit the entry, insert and 

delete slides. In notes view, you can edit the entry.
Outline > In outline view, expand and collapse one or all 

slides.
Navigate > In all views, move to next or previous page or 

slide.
Goto Go to another view.
Pitch > Start or stop pitch device.
Print In outline or notes view, print document by 

sending it via Multimedia, Bluetooth® or infrared.
Exit > In thumb view, choose Close and save, Close 

and save as, or Close and discard.

Note: Animation, multimedia, or embedded objects in Microsoft® 
PowerPoint® documents cannot be displayed on the phone.
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GAMES
Your phone is supplied with two games, MicroGolf and Balloon-
Headed Boy. 

Download Games
See Download Files from the Internet on page 95. For customer 
support of downloaded content, visit the respective supplier’s 
website.   

Free content is available for your X700 phone. For downloading 
information, visit www.panasonicbox.com. Availability of this 
service is dependent on your country/region or network. The 
downloaded content is free, however there will be a 
communication fee to download.

MICROGOLF GAME
Play 18 holes of a miniature golf game.
From Games application:
1. Open MicroGolf icon.
2. Navigation options:   

Note: For customer support and more information on MicroGolf and 
Balloon-Headed Boy games, visit the forum at 
www.morpheme.co.uk.

Note: Panasonic is not responsible for the performance of downloaded 
content or possible corruption of phone software.

Rotate clockwise: Scroll  or press . 

Rotate counterclockwise: Scroll  or press .

Snap direction to the diagonal: Press , , , or .

Increase power: Press  or . Release to hit the 
ball.

Toggle golfer on or off: Press .
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BALLOON-HEADED BOY GAME
Move Balloon-Headed Boy through different levels to rescue 
balloons to bring to the birthday party. Watch out for the frogs!

From Games application:
1. Open Balloon-Headed Boy icon.
2. The game may show hints of which key to press to move.
3. Navigation options:   

Toggle manual scroll to see 
further than ball centered view 
allows:

Press . Scroll for 4 directions to 
move the view. 

Switch sound on or off: See Options menu.

Move right: Scroll  or press . 

Move left: Scroll  or press .

Move up: Scroll  or press .

Move down: Scroll  or press .

Go back one screen: Press . 

Switch sound on or off: Press  when at title screen 
below speaker icon.
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FAVOURITES
Favourites serves as a “bulletin board” storing shortcuts to your 
frequently used applications or documents stored in phone 
memory or miniSD Card.

OPEN A FAVOURITES SHORTCUT
Open Favourites application:
1. Scroll to the desired shortcut; press 

Options and select Open. Or, press  
to open.

ADD A SHORTCUT TO 
FAVOURITES
1. Open the item within the application or 

open the document in which you want to store a shortcut in 
Favourites.

2. Press Options and select Add to favourites.
• Adding to Favourites is available only for certain 

applications. 

MANAGE FAVOURITES
Open Favourites application:
1. Scroll to the desired shortcut.
2. Press Options and select:  
Edit shortcut 
name

Change the name of the shortcut.

Shortcut icon When this option appears, choose a different icon 
picture by scrolling through grid.

Move A checkmark appears on the shortcut icon. Scroll 
 or  to move to desired location, then press 

OK.
List view/Grid 
view

View the shortcuts in a list view or grid view.

Delete shortcut Remove shortcut from Favourites.
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To change the wallpaper of the Favourites screen, see Change 
Wallpaper or Screensaver on page 115.

Note: The default shortcuts to Today in Calendar, Inbox in Messages, 
and Notepad cannot be deleted nor can the icon be changed.
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ACCESSORIES
Many accessories are available for your Panasonic phone. 
Contact your wireless service provider to purchase Genuine 
Panasonic accessories. Using non-Panasonic accessories or 
accessories not recommended by your wireless service provider 
may result in poor performance of your phone, or even cause an 
electrical hazard.

BATTERY LITHIUM-ION  780 mAh
(EB-BSX700)
Carry a spare battery.

TRAVEL CHARGER
(EB-CAX70AU) (EB-CAX70CN) (EB-CAX70EU)
(EB-CAX70UK) (EB-CAX70US)
Recharge the battery using any electrical outlet. 
Plugs for use in many countries are available.

miniSD CARD
MiniSD (secure data) memory card stores sound, 
video, picture, and voice files. Card memory size 
varies.

miniSD CARD ADAPTER
This adapter allows you to use your miniSD Card in 
a standard SD socket. See miniSD Card on 
page 143.

Warning: When you use a miniSD Card with an SD Memory Card
application device, please insert the card in the miniSD
adapter which is included in the package. When you use the
card with an SD Memory Card application device, please
insert and remove the card with the adapter at the same time
and never leave the adapter in the device.
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CAR CHARGER (DC ADAPTER)
(EB-CDX70)
Recharge the battery using your vehicle’s cigarette 
lighter socket.

CAR HOLDER
(EB-KAX700)
Mounted in your vehicle to store your phone. Use 
with personal handsfree headset for handsfree 
operation.

CARRY CASE
(EB-YKX700)
Clip your case to your clothing or purse to keep your 
phone close.

PERSONAL HANDSFREE HEADSET
(EB-EMD87)
Plug into your phone and talk without holding the 
phone to your ear. 

PRODUCT CD
Transfer data between your phone and your PC, 
using Bluetooth®, Infrared, or USB data cable.

USB DATA CABLE WITH CHARGING 
CAPABILITY
(EB-UCX700)
Use this to connect your phone to a PC to transfer 
data between them. Use in conjunction with the 
software provided on the CD-ROM.
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BLUETOOTH® HEADSET
(EB-BHX70)
Talk handsfree and without wires. Place the headset 
on your ear and the phone in your pocket, with no 
wires connecting the two.

BLUETOOTH® CAR KIT
Parrot model CK3000 or Parrot model DriveBlue
Made by Parrot, these Bluetooth® enabled 
handsfree car kits allow you to use your phone 
handsfree in your car. Model CK3000 requires 
installation, model DriveBlue plugs into your car 
cigarette lighter.

How to identify a genuine Panasonic accessory
Panasonic produces some of the most advanced mobile phones 
available. So, as you’d expect from this class leader, the range of 
accessories are second to none. Most genuine Panasonic 
accessories will have a label showing an “EB-XXXXX” model 
number.



   169

TROUBLESHOOTING
PROBLEMS

Problem Remedy

Phone does not switch 
on

• Check that the battery is properly installed 
and charged.

• Press and hold  for at least two 
seconds.

Short battery life for a 
new battery

Battery life is reduced when:
• playing games
• leaving Bluetooth® switched on
• taking pictures with Camera
• recording video clips with Video recorder
• recording sound clips with Recorder
• using the Photolight often
• browsing the Internet
• downloading data
• leaving Cell Broadcast switched on
• phone is in a weak service area, requiring 

more battery power

Battery charging 
indicator does not 
appear, and phone 
cannot be switched on 
when starting battery 
charge session

Allow phone to charge for a few minutes 
before switching on. Battery may have been 
fully discharged.

Battery fails to charge Do not connect the Travel Charger until after 
the battery has been installed.

Display looks faded Check the Brightness setting (see Display 
Settings on page 117).

Emergency calls 
cannot be made

Check that the antenna symbol  is 
displayed - move to a coverage area and 
operate your phone when the antenna symbol 
appears. 
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Error Messages
These are some of the important error messages which may be 
displayed.

Calls cannot be made 
or received

• Check to make sure the phone is switched 
on.

• If keypad is locked, press Unlock softkey, 
then press .

• If phone is locked, enter lock code.
• Check that the network signal strength 

indicator  displays at least one bar. Move 
to a stronger coverage area.

• If no network name appears, the phone may 
not be registered to a network. Move to 
another area and watch for the phone to 
register to a network.

• Check Call barring, Fixed dialling, Closed 
user group, and Call divert settings in 
Settings application.

Note: The quality of display images may vary depending on the object 
or environment.
Display images may distort when shooting moving objects, 
especially in a fast moving environment. 

Error Message Meaning

Unable to install
Unable to install game, ringing tone, 
application, etc., for various reasons such as 
not enough memory, or downloading failed.

No access points 
defined. Define now?

You need to set up an access point for your 
phone to access the service you are 
requesting, such as Multimedia messaging, e-
mail, browsing the Internet, or chat.

Problem Remedy
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Memory full 
Phone memory is full. Delete some files before 
new files can be stored. See Shared Phone 
memory on page 31.

No network coverage There is no network service in your current 
location.

Network busy 
Connection error

Network is overloaded with calls or there was 
an error trying to connect to the network.

Unable to send  
message. Maximum 
message size is xxx

File size of object attached to message is too 
large to send. The xxx will be replaced by a file 
size. You may be able to send the file by 
infrared, Bluetooth®, or transfer by PC 
Software Suite.

Unable to connect. No 
network coverage. Cannot connect to server you are requesting.

Secure connection not 
available Network cannot establish a secure connection.

SIM card registration 
failed

The network cannot register your SIM card. 
Contact your wireless service provider.

PIN code blocked. 
Enter PUK code:

PIN code was entered incorrectly 3 times, 
therefore the SIM card is locked. Enter the 
PUK code, supplied by wireless service 
provider.

PIN2 code blocked. 
Enter PUK2 code:

PIN2 code was entered incorrectly 3 times, 
therefore the SIM card is locked. Enter the 
PUK2 code, supplied by wireless service 
provider.

SIM card rejected
The phone is set to accept only certain SIM 
cards. It will not accept the currently inserted 
SIM card.

Error Message Meaning



172      

INDEX

A
About (copyrights) . . . . . . . 135
Access point settings  . . . . 118
Accessories  . . . . . . . . . . . 166
Active clamshell  . . . . . . . . 118
Alarm set

Calendar  . . . . . . . . . . . . 43
Clock  . . . . . . . . . . . . . . 130

Applications
Close  . . . . . . . . . . . . . . . 31
Menu map  . . . . . . . . . . . 33
Navigating  . . . . . . . . . . . 27
Open  . . . . . . . . . . . . . . . 31
Options softkey  . . . . . . . 28

B
Barring  . . . . . . . . . . . . . . . 127
Battery

Charging  . . . . . . . . . . . . . 5
Installing . . . . . . . . . . . . . . 4
Removing . . . . . . . . . . . . . 4

Bluetooth . . . . . . . . . . . . . . 100
Browser . . . . . . . . . . . . . 90–97

Bookmarks . . . . . . . . . . . 94
Connect to Internet  . . . . 91
Download files 
from Internet  . . . . . . . . . 95
Online options  . . . . . . . . 93
Saved pages  . . . . . . . . . 96
Set up  . . . . . . . . . . . . . . 91
Settings  . . . . . . . . . . . . . 95

C
Calculator  . . . . . . . . . . . . . 137
Calendar . . . . . . . . . . . . 43–47

Alarm set . . . . . . . . . . . . 43
Chinese Lunar calendar  47
Create new  . . . . . . . . . . 43
Send events  . . . . . . . . . 46
Settings . . . . . . . . . . . . . 46
Views  . . . . . . . . . . . . . . 44

Call
Answer by opening flip  118
Answering . . . . . . . . . . . 18
Duration  . . . . . . . . . . . 153
Ending . . . . . . . . . . . . . . 23
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Cell broadcast messages . . 69
Certificate management  . . 125
Chinese Lunar calendar  . . . 47
Clip art, add to photos . . . . . 83
Clock . . . . . . . . . . . . . . . . . 129
Close applications . . . . . . . . 31
Closed user group  . . . . . . 124
Conference calls . . . . . . . . . 22
Connection manager  . . . . 105
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Fax modem  . . . . . . . . . 105
Infrared  . . . . . . . . . . . . 103
Operator . . . . . . . . . . . . . 97

Contacts  . . . . . . . . . . . . 35–42
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Find  . . . . . . . . . . . . . . . . 37
Groups . . . . . . . . . . . . . . 41
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My numbers . . . . . . . . . . 36
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SIM directory  . . . . . . . . . 35

Converter  . . . . . . . . . . . . . 138
Create e-mail messages . . . 53
Create multimedia messages 51
Create text message . . . . . . 50
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Access points . . . . . . . . 119
Definition  . . . . . . . . . . . . 91

Device manager  . . . . . . . . 109
Dictionary  . . . . . . . . . . . . . . 24

E
Eject miniSD card . . . . . . . . . 9
E-mail messages  . . . . . . . . 58
Emergency calls . . . . . . . . . 17
Ending calls  . . . . . . . . . . . . 23
Enhancement settings  . . . 128

F
Favourites  . . . . . . . . . . . . 164
Fax modem  . . . . . . . . . . . 105
File manager  . . . . . . . . . . 148
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Send sound clips  . . . . . . . . 78
Send video clips  . . . . . . . . . 78
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Barring  . . . . . . . . . . . . 127
Call  . . . . . . . . . . . . . . . 117
Call divert  . . . . . . . . . . 126
Certificate management 125
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Connection  . . . . . . . . . 118
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Network . . . . . . . . . . . . 128
Phone  . . . . . . . . . . . . . 116
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Streaming media, play . . . . 77
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Take a picture  . . . . . . . . . . 71
Text entry
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Tools  . . . . . . . . . . . . 137–151
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U
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USB  . . . . . . . . . . . . . 105, 167

V
Video clips, play  . . . . . . . . . 77
Video player controls  . . . . . 78
Video recorder  . . . . . . . . . . 87
Voice commands  . . . . . . . 132
Voice dial  . . . . . . . . . . . . . 133
Voice mail . . . . . . . . . . . . . . 48
Voice recorder  . . . . . . . . . 140
Volume

Call . . . . . . . . . . . . . . . . . 20
Player . . . . . . . . . . . . . . . 78
Ringtone  . . . . . . . . . . . 113
Sound clip  . . . . . . . . . . . 78
Video clip . . . . . . . . . . . . 78

W
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Video recorder . . . . . . . . 87
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